
Vantage System Administration        

8.2 

System Administration

September 2021 2403261058



Copyrights and Trademark Notices
Copyright © 2024 Telestream, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
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Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.
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MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.
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Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 
Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 
61000-4-4, EN 61000-4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE 
Marking (Europe)

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Using the Vantage 
Management Console

This chapter describes how to use the Vantage Management Console (often referred to 
simply as the console or the VMC). The VMC enables Vantage system administrators to 
configure their Vantage domain and to scale Vantage services across multiple servers 
(creating a Vantage array) to meet their operating requirements.

Note: Features in products for which you don't have a license are disabled and 
indicate that you need a license to use them.

Topics
■ Introduction

■ Starting the Vantage Management Console

■ Managing the Vantage Domain Connection

■ Using the Vantage Management Console Workspace

■ Managing Tips and Warnings

■ Using the Help System

■ Displaying Software and Database Versions

■ Vantage Management Console Reference
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Introduction
The Vantage Management Console is designed to facilitate centralized management of 
the software components and resources that comprise a Vantage domain, including 
settings and options, Vantage catalogs, Vantage stores, Vantage services, licenses, 
workflow design items, and client application configurations. The Vantage 
Management Console also provides real-time status details for services, machines, and 
the domain at large, plus a domain backup/restore utility and other support utilities.

The Vantage Management Console manages a single Vantage domain at a time. 

Caution: Although the Vantage Management Console is a multi-user 
application, modifying a domain is intended to be done by one user on one 
domain at a time. Connecting multiple consoles to the same Vantage domain for 
any other purpose than viewing status and configuration details is not 
recommended and can lead to domain configuration problems.

Each Vantage domain includes a single Vantage domain database, which consists of a 
Microsoft SQL Server instance, Vantage domain database software, and database files. 
All configurations that you create with the Vantage Management Console are stored in 
the Vantage domain database.

Many organizations implement Vantage as a single domain. However, in large facilities, 
you may have several separate and independent Vantage domains for scaling to high-
volume workflow processing or for specialization and departmentalization purposes.

In a facility with multiple Vantage domains, you can connect to any Vantage domain in 
the network from any Management Console in the network.
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Starting the Vantage Management Console
To start the Management Console, do one of the following:

• Select Start > Programs > Telestream > Vantage > Vantage Management Console

• Double-click the Vantage Management Console shortcut on your desktop:

After you start the Vantage Management Console, your domain configuration may 
prompt you for additional information, which is described in the following topics:

■ Selecting a Domain

■ Entering a Username and Password

Selecting a Domain
Each time you start the Vantage Management Console, the program connects to the 
last domain to which it was connected. If you are starting the program for the first time, 
the Vantage Management Console polls the network for domains in the same subnet, 
and displays the domains that responded in a list, as depicted here:

The name for each Vantage domain is the name of the computer that hosts the Vantage 
domain database. If you do not know which domain you should connect to, see your 
Vantage domain administrator.

To select a domain, do this:

1. Click Search. Select the desired domain if it displays in the list (as shown in the  
figure above). 
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2. If the Vantage domain’s SQL database default username and password were 
changed during installation, do this:

a. Click Connection Settings to display a dialog that you can use to specify the 
correct username and password for MS SQL Server:

b. Enter the Vantage domain database SQL Server account username and password 
(obtained from your Vantage administrator).

3. If the domain you want is not in the list (not in your current subnet), do this:

a. Click Specify Vantage Domain name/IP address in the bottom left corner to display 
a dialog to manually enter the domain, as shown here:

b. Enter the domain name or IP address of the server that hosts the Vantage 
domain database (for example, VantageServer203 or 192.168.1.1).

If you do not know IP address of the server that hosts the Vantage domain data-
base, see your Vantage domain administrator.

4. Click OK to continue.

Entering a Username and Password
User administration requiring login is disabled by default in Vantage. However, if it is 
enabled, when you start the Vantage Management Console and access a Vantage 
domain, you are asked to log in (the  figure, below) by providing a Username and 
Password. The login is your Vantage user name and password, or if Active Directory is 
enabled, your Windows Active Directory user name and password. (See Managing 
Vantage Users for login details.)
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If the dialog prompts for credentials to a domain you cannot or do not want to access, 
click Cancel and select the domain to which you want to connect as described in 
Selecting a Different Domain.

When the dialog displays the correct domain name, enter your username, and 
password, if required, and click OK to connect.

The default Vantage user is Administrator, with no password assigned, and this user has 
Administrator privileges. Only Vantage users who are administrators can log into the 
Vantage Management Console.

Note: All user passwords are encrypted in the Vantage domain database.
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Managing the Vantage Domain Connection
Vantage Management Console connects to one domain at a time. You must connect to 
a domain before you can use the Vantage Management Console to manage that 
domain. In an environment where more than one Vantage domain is operating, you 
can use the same Management Console to connect to any single domain.

The following topics describe tasks for managing your domain connection:

■ Identifying the Selected Domain

■ Selecting a Different Domain

Identifying the Selected Domain
Each Vantage domain is identified by the name of the computer on which the Vantage 
domain database is hosted. To determine which domain the Management Console is 
connected to, note the [Vantage domain name:user name] in the window title:

Current Vantage [Domain:User]
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Selecting a Different Domain
To select a different Vantage domain, do this:

1. Select File > Recent Domains, and choose from the list of recently used domains. 
Click OK in the dialog shown below. (You can also enter a domain name or IP in the 
dialog shown and click OK.)

2. If the domain you want is not shown, click File > Change Vantage Domain.

3. Select a domain from the list and click OK. (For more details, see Selecting a 
Domain.)

When you change domains, the Vantage Management Console closes its connection to 
the current domain’s Vantage domain database and connects to the new domain’s 
database, refreshing the details of all of its components.
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Using the Vantage Management Console 
Workspace

The Vantage Management Console window displays two panels: Vantage configuration 
components (left) and to the right, tabbed configuration settings as shown here:

Details Panel
To the right of the components panel is the configuration settings panel, which lists the 
settings for the Vantage component you’ve selected in the components panel.

For example, when you select the Settings & Options component, the details panel 
displays all the configuration options for this component as shown in the figure above. 
For the Settings and Options component, the details panel options are divided into 
four tabs. The details panel for other components is further divided into subpanels. 
These tabs and subpanels help to organize configuration options.

Components Panel Configuration Settings Panel
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Managing Tips and Warnings
To restore tip and warning messages that were previously disabled by clicking Don’t 
show me this again, select Options > Restore Tips & Warnings. When tips and warnings 
are restored, these tips and warnings display as you interact with the Vantage 
Management Console.

To disable all tip and warning messages select Options > Hide Tips & Warnings. These 
messages can also be individually disabled by clicking Don’t show me this again when 
they appear.
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Using the Help System
The Vantage Management Console provides the following help documentation:

■ Context-Sensitive Help

■ The Vantage Domain Management Guide

■ Tool Tips

■ Online Help

Context-Sensitive Help
When you are using the Vantage Management Console, context-sensitive help displays 
the appropriate section of the Vantage Domain Management Guide (which is this 
guide). For example, if you select the Storage component in the components panel and 
open context-sensitive help, Vantage displays the Managing Vantage File Storage 
section of this guide. To start context-sensitive help, press F1 or click the ? button.

The Vantage Domain Management Guide
The Vantage Domain Management Guide is available in PDF and program help formats. 
When you use context-sensitive help, you are opening the program help version of this 
guide to a section appropriate for the configuration settings you are viewing. You can 
also open this guide by selecting one of the following:

• Help > Contents—Displays the table of contents of this guide.

• Help > Index—Displays an index for this guide.

• Help > Search—Displays a search panel that you can use to search for information.

The Favorites tab in the help program can be used to save and display topics you want 
to quickly access. While viewing a help topic, click the Add button to add the current 
topic to the favorites list. To remove a topic, select the topic and click Remove.

Tool Tips
Tool tips display information about buttons and configuration options in the Vantage 
Management Console. To display the tool tip for a button or option, hover the cursor 
over the button or option.

Online Help
The latest documentation is posted on the Telestream.net web site. To quickly access 
the Telestream online documentation from within Vantage Management Console, 
select Help > Online Help.

Note: Access to the Vantage Online Help requires an Internet connection.

http://www.telestream.net/telestream-support/vantage/support.htm
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Displaying Software and Database Versions
The Vantage software version is listed in the Help menu of Vantage programs. To view 
the software version of a Vantage program, select Help > About....

The Vantage database version is listed in the Help menu of the Vantage Management 
Console and the Vantage Workflow Designer. To view the Vantage database version in 
those programs, select Help > Database Version.

You can also find versions listed in the Vantage Management Console > Support 
Utilities > Software Versions by Machine folder. Click on a machine name in the folder 
to display the Vantage version and Vantage services versions installed on that machine.
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Vantage Management Console Reference
The following topics provide descriptions of Vantage Management Console controls:

■ Vantage Management Console Menus

■ Vantage Component Descriptions

Vantage Management Console Menus
This table describes the Vantage Management Console menus.

Menu Selection Description

File Change 
Vantage 
Domain

Displays a dialog that you can use to select another 
domain as described in Selecting a Domain.

Recent 
Domains

Lists recently accessed domains. Select one to open a 
dialog for accessing that domain.

Exit Quits the Vantage Management Console Program.

Options Restore Tips 
& Warnings

Restores tip and warning messages after they have been 
disabled. See Managing Tips and Warnings.

Hide Tips & 
Warnings

Hides tip and warning messages. See Managing Tips and 
Warnings.

Prompt for 
login next 
time 
application 
is launched.

When this selection is checked (enabled), a password is 
required for the next login. If unchecked, Vantage 
remembers the password and does not ask for it next 
time the user launches the Vantage Management 
Console application.

Help Contents Displays the contents of this guide in program help.

Index Displays an index of this guide in program help.

Search Displays a search panel that you can use to search for 
information in the program help.

Online Help When you are connected to the Internet, this option 
opens the Vantage documentation web page in your 
browser.

About Displays version information for the Vantage 
Management Console program.

Database 
Version

Displays the version number of the Vantage Domain 
Database.
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Vantage Component Descriptions
This table describes the components in the Vantage Management Console 
components (left) panel.

Parameter Description

Settings & Options Use this panel to display settings that configure Vantage 
operation. Tabs include General for overall settings, Email 
for configuring automated notifications, Authorization 
for adding user accounts, Mapped Drives for mapping 
Windows drives to UNC paths, DIVA for configuring a 
DIVA connection, Signiant for configuring a Signiant 
server connection, Cloud for adding various accounts for 
cloud based functionality, Avid for server login for Avid-
related actions, Storage Management, and Dashboard 
Links for adding your own URLs to the Web Apps panel. 
For details, see Settings and Options in this chapter and 
also Managing Settings and Options in the Managing the 
Vantage Domain chapter.

Catalogs The Catalogs panel allows you to manage catalogs and 
the binders they contain. For more information, see 
Managing Catalogs in the Vantage Management Console in 
the Vantage Domain Management Guide or the Vantage 
Workflow Administration Guide.

Storage The Storage panel allows you to manage the Vantage 
Stores and Vantage Folders where Vantage files are 
stored. For more information, see Managing Vantage File 
Storage in the Vantage Domain Management Guide or the 
Vantage System Administration Guide.

Services Use the Services panel to configure Vantage services. 
Using a right-click, you can put services in or out of 
Maintenance mode or restart them. Using the tabs at the 
bottom, you can manage various service settings. For 
details, see Managing Services in the Vantage Domain 
Management Guide or the Vantage System Administration 
Guide.

Licenses Use the Licenses panel to view, add, delete, and 
deactivate licenses for Vantage features. For more 
information, see Managing Licenses in the Vantage 
Domain Management Guide or the Vantage System 
Administration Guide.
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Status The Status selections allow you to monitor and manage 
performance of actions, machines, and the domain. See 
Viewing Status in the Vantage Domain Management Guide 
or the Vantage Workflow Administration Guide.

Capture Inventory The Capture Inventory panel is a Vantage Live Capture 
feature that shows live capture sources present in the 
domain. See the Vantage Live Capture Guide for details.

Workflow Design Items See Working with Workflow Design Items in the Vantage 
Domain Management Guide or the Vantage Workflow 
Administration Guide for the following topics describing 
Workflow Design Items menu selections: 

• Managing Vantage Workflows
• Managing Workflow Categories
• Managing Media Nicknames
• Managing Metadata Labels
• Managing Attachment Nicknames
• Managing Variables
• Managing Scripts
• Managing Style Sheets
• Managing Action Default Settings
• Managing Nexus Definitions

Domain Workflow 
Analytics

See Viewing Workflow and Action Analytics in the Vantage 
Domain Management Guide or the Vantage Workflow 
Administration Guide.

Utilization Shows a bar graph of the average demand for a selected 
service type over a specified time period across the entire 
Vantage domain. Waiting times for complete sessions are 
used to color-code the graph, adding a visual indication 
of the waiting times resulting from the demand. This 
graph can be viewed on a day-by-day or hour-by-hour 
basis. See Monitoring Utilization in the Vantage Domain 
Management Guide for details.

Parameter Description
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Support Utilities Use the Support Utilities panel to access Vantage utilities. 
Search the Vantage Domain Management Guide for the 
following topics for details:

• Using the Data Collection Utility
• Using the Change Log
• Using the Error Log
• Listing Actions By Service
• Displaying Plug-in Versions
• Displaying Software Versions by Machine

Application 
Configurations

Use the Application Configurations panel to select a 
Vantage application to configure. For more information, 
see these topics in the Vantage Domain Management 
Guide:

• Configuring Job Status Views
• Setting up Workflow Portal
• Creating Dublist Portal Configurations and Dublist 

Schemes

Report Configurations See Creating Report Configurations in the Vantage Domain 
Management Guide or the Vantage Workflow 
Administration Guide.

Fulfillment Schemes See Creating Dublist Portal Configurations and Dublist 
Schemes in the Vantage Domain Management Guide. Also 
see Configuring Catch Server Schemes.

Syndication Provides the capability of creating templates for use by 
the TrafficManager Syndication feature. See the 
Managing the Vantage Domain chapter in the Vantage 
Domain Management Guide, and see the TrafficManager 
User Guide.

Task Rules Allows creating multiple rules to govern machine and 
domain capacities under different operating 
circumstances. See Managing Task Scheduling and Load 
Balancing in the Vantage Domain Management Guide.

Client Connections Presents a list of all open Vantage clients and their hosts.

Parameter Description
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Users Use the Users panel to manage how Vantage users access 
and use Vantage features. For more information, see 
Managing Vantage Users in the Vantage Domain 
Management Guide or the Vantage System Administration 
Guide.

Domain Management Use the Domain Management panel to back up and 
restore or shrink the Vantage domain database. For more 
information, see Backing Up and Restoring the Vantage 
Domain Database in the Vantage Domain Management 
Guide or the Vantage System Administration Guide.

ComponentPac 
Management

Allows installing and uninstalling updates to Vantage 
actions and services using ComponentPacs. This method 
makes smaller, more frequent Vantage updates possible. 
For details, see Managing ComponentPacs in the Vantage 
Domain Management Guide.

Parameter Description
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Settings and Options
The table below provides descriptions and references for the Settings & Options 
parameters. 

 

Tab Parameter Description

General Check one of the 
following Task 
Scheduling modes:

- Session Based
- Cost Based
- Task Based

Enables the selected method of task 
scheduling. For more information, see 
Managing Task Scheduling and Load Balancing 
in the Vantage System Administration Guide or 
the Vantage Domain Management Guide.

Enable Open Workflows Enables the Open Workflows option. To create 
open workflows, you must also enable them 
in specific workflows and actions. For details, 
see the Vantage User Guide.

Enable user 
administration

Enables or disables Vantage user 
management. Includes a check box to enable 
using Windows Active Directory, so your users 
can log in with their Windows credentials. See 
Managing Vantage Users in the Vantage 
System Administration Guide or the Vantage 
Domain Management Guide.

Enable Lightspeed 
Fallback

Allows jobs to run on CPU-based servers 
when all Lightspeed GPU servers are 
unavailable.

Enable use of Fully 
Qualified Domain Name 
(FQDN)

Enables Vantage services to use an FQDN for 
identification. An FQDN follows this pattern 
[host name].[domain].[top level domain], for 
example, myhost.telestream.net. Restart all 
services after changing this selection. After 
restart, the services will display messages 
indicating that they are using FQDN. 

Expire failed jobs See Enabling and Disabling Expiration of Failed 
Jobs in the Vantage Workflow Administration 
Guide or the Vantage Domain Management 
Guide.
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Detailed job progress When enabled, displays more detailed job 
progress information in the Workflow 
Designer Job Status table Progress column. 
When disabled, displays less detailed 
information. Enabling increases database 
activity, potentially reducing performance, 
especially on an all-in-one domain.

Enable Job Failure in Lieu 
of Impairment 
(Watermarking)

When enabled, jobs will fail when a license 
feature is unavailable in lieu of watermarking. 
Disabled by default.

Job Expiration When enabled, allows user specified time 
period for job expiration based on arrival of 
new jobs. 

Include completed jobs 
in Domain Job Status

Disabled by default. When this feature is 
enabled, the Workflow Designer Domain Job 
Status tab shows all jobs in the Vantage 
domain, including completed jobs. 

Vantage Workflow 
Designer Grid

See Setting the Vantage Workflow Designer 
Grid Width/Height in the Vantage Workflow 
Administration Guide or the Vantage Domain 
Management Guide.

Report Retention Time Determines how many days of historical 
logging to retain (for use in historical Service 
Reports). Default: the past 30 days. Range: 1 
day-730 days (2 years). See Service Reports.

Location for workflow 
backups

Browse to specify a UNC location where 
workflow backups can be saved when actions 
are upgraded. If not specified, backups are 
stored on the local drive in a 
VantageWorkflowBackup directory.

Use AWS S3 Event Queues 
for monitor actions with 
S3 File systems

When enabled, Monitor actions such as 
Watch/Associate which are targeting an S3 
file system uses event-based mode. If 
disabled (default), actions fall back to 
directory listing mode.

Tab Parameter Description
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Configure Idle Service 
Allocation

Allows you to specify the order services are 
interrogated when determining loads when 
the Vantage domain is in an idle state. This 
enforces a specific ordering of how services 
are selected for work based upon what the 
user has specified.

Email Credentials for sending 
email notifications about 
Vantage events

See Configuring Vantage Email Notifications in 
the Vantage Domain Management Guide.

Authorization Credentials for Vantage 
remote login to storage

See Specifying Authorization Credentials for 
Server Access in the Vantage Domain 
Management Guide.

Mapped Drives Map network drives to 
UNC path 

See Assigning Mapped Drives in the Vantage 
Domain Management Guide.

DIVA Identity and credentials 
for accessing a specific 
Content Manager | DIVA.

See Managing Content Manager | DIVA 
Connections in the Vantage Domain 
Management Guide.

Signiant Credentials for remote 
login to Signiant

Allows saving credentials for connecting to 
Signiant servers from Vantage workflows. See 
Managing Signiant Connections in the Vantage 
Domain Management Guide.

Cloud (Telestream) Credentials for logging 
into Vantage Cloud

Allows saving credentials for connecting to 
Vantage Cloud from Vantage workflows. See 
Configuring Cloud Account Settings in the 
Vantage Domain Management Guide.

Storage Management Configurations for Live 
store capacity and file 
retention.

Allows for automated self management of 
Live store cleanup. See Configuring Storage 
Management Settings.

Avid Configurations and 
credentials for accessing 
Avid servers.

Allows saving credentials for connecting to 
Avid servers from Vantage workflows. See 
Configuring Avid Server Settings.

Dashboard Links Controls for creating, 
deleting, saving, 
importing, and exporting 
frequently used URLs.

Provides controls for entering and saving 
URLs that display on the Vantage Web Apps 
page as bookmarks to frequently-used links. 
See Creating Dashboard Links.

Tab Parameter Description
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Managing the Vantage 
Domain

This chapter describes how to manage a Vantage domain. Topics are arranged in the 
order of the Management Console left panel. 

Some topics are covered in the Vantage Workflow Components chapter of the Domain 
Management Guide because they are more closely related to workflow design than 
system administration. These include Catalogs, Workflow Design Items, Domain 
Workflow Analytics, Application Configurations, Report Configurations, and Fulfillment 
Schemes. 

Note: Features in products for which you don't have a license are disabled and 
indicate that you need a license to use them.

Topics
■ Managing Settings and Options

■ Managing Vantage File Storage

■ Managing Services

■ Managing Licenses

■ Enabling Open Workflows

■ Viewing Status

■ Monitoring Utilization

■ Using Support Utilities

■ Managing Task Scheduling and Load Balancing

■ Viewing Client Connections

■ Managing Vantage Users

■ Managing Domains

■ Managing ComponentPacs
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Managing Settings and Options
The Settings and Options left panel selection opens a set of tabbed panels on the right 
that control some of the overall features of Vantage.

■ Updating General Settings

■ Configuring Vantage Email Notifications

■ Specifying Authorization Credentials for Server Access

■ Assigning Mapped Drives

■ Managing Signiant Connections

■ Configuring Cloud Account Settings

■ Configuring Storage Management Settings

■ Configuring Avid Server Settings

■ Creating Dashboard Links
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Updating General Settings 
The Settings and Options General panel includes these selections: 

• Task Scheduling—Enables task scheduling and load balancing. See Monitoring Utili-
zation for details.

• Open Workflows—Enables the Open Workflows feature. This must be enabled and 
licensed before open workflows can be used in Workflow Designer. Refer to the 
Vantage User Guide for information about open workflows and how to use them. 

• User Administration—Enables user administration, which allows an administrator 
to create user accounts and passwords for logging into Vantage clients. When dis-
abled, no login is required to use the clients. If Active Directory is enabled, existing 
Windows user accounts are enabled, but the administrator still needs to add the 
specific users. To add users, select Users near the bottom of the left panel (see Man-
aging Vantage Users for details about how to add users).

• Enable Lightspeed fallback—Check to allow Lightspeed actions to use a multicore 
server if a Lightspeed server isn’t available when the action is ready to execute. See 
Enabling Lightspeed Fallback in the Vantage Domain Management Guide.

• Enable use of Fully Qualified Domain Name—Enables use of Fully Qualified Domain 
Names (FQDN) in Vantage. An FQDN follows this pattern [host name].[domain].[top 
level domain], for example, myhost.telestream.net.

• Expire failed jobs—Check to allow failed jobs to be expired with other jobs. If dis-
abled, failed jobs must be manually deleted. See also Enabling and Disabling Expira-
tion of Failed Jobs in the Vantage Domain Management Guide.

• Detailed job progress—Check to include more details in job progress reporting. 
This feature may slow down overall system performance.

• Enable Job Failure in Lieu of Impairment (Watermarking)—Check to fail jobs rather 
than add a watermark.

• Job Expiration—When enabled, allows user specified time period for job expiration 
based on arrival of new jobs.

• Include completed jobs in Domain Job Status—Check to include completed jobs in 
Workflow Designer’s Domain Job Status panel. Uncheck to exclude completed jobs.

• Workflow Designer grid size (visible only if Show Grid Lines is enabled in the WFD). 
See also Setting the Vantage Workflow Designer Grid Width/Height in the Vantage 
Domain Management Guide.

• Report Retention Time—deletes service report historical data after the number of 
days specified. See also Generating Reports later in this chapter.

• Location for workflow backups—Browse to specify a UNC path to the location 
where you want to store your workflow backups. See also Backing Up and Restoring 
the Vantage Domain Database later in this chapter.

• Use AWS S3 Event Queues for Watch actions with S3 File systems—Enable to use 
event based mode for Monitor actions such as Watch/Associate which are targeting 
an S3 file system
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• Configure Idle Service Allocation—When selected and enabled, allows you to spec-
ify the order services are interrogated when determining loads when the Vantage 
domain is in an idle state. This enforces a specific ordering of how services are 
selected for work based upon what the user has specified.
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Configuring Vantage Email Notifications
Vantage can send email messages to announce workflow and service events.

Message actions in Vantage workflows can be configured to send email messages for 
workflow events. The email destination address may be for an individual, a system, or 
an alias for a group of Vantage users or administrators.

Note: Until you configure these settings, you will not be able to execute Message 
actions that utilize email in your workflows.

If a Vantage Service starts or stops running, or if a service fails, Vantage sends an email 
to the administrator email address.

Note: An email is not sent when a Vantage Service enters or exits Maintenance Mode.

To manage email notifications, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage Domain Management Guide.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Email tab.

4. Configure the email parameters, which are described in the table below.

5. Click the Save button .

Option Description

Hostname | IP Address Supply the computer’s host name or IP address of the 
SMTP server.

SMTP Port Supply the port number of the SMTP server.

SMTP Host Requires 
Authentication

Check if the SMTP server is configured to require 
authentication.

Username and Password Supply the user name and password if SMTP Host 
Requires Authentication is checked.

This server requires an 
encrypted connection 
(SSL)

Check this check box if SMTP server requires an 
encrypted connection.

Administrator Email 
Address

Supply the email address of the Vantage administrator. 
The email specified for this account can be an alias for a 
larger group, maintained by your IT department.

You may also specify a display name for emails by 
separating it from email address with a space: 
MyDisplayName myemail@telestream.net 
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Send Test Email Click to test your settings by sending an email to the 
administrator email address.

Email administrator upon 
service starting

Check to email the administrator when a service starts. 
For example, if a Vantage machine hosting an Analysis 
and a Monitor service is started without any problems, 
two emails are sent reporting the starting of each service.

Email administrator upon 
service stopping

Check this check box to email the administrator when a 
service stops.

Email administrator upon 
service failure

Check to email the administrator when this service fails 
(crashes or otherwise stops unexpectedly). For example, if 
a Vantage Analysis service is stopped from the Task 
Manager (forced termination), an email is sent to the 
administrator. Or, if a Vantage Analysis service crashes 
during start-up, an email is also sent to the administrator.

Option Description
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Specifying Authorization Credentials for Server Access
This feature allows you to specify credentials (user name and password) for a server 
path that is not located in the Windows domain or workgroup for which the Vantage 
application is authorized. For example, if Vantage services are configured with a user 
name and password for Domain A or Workgroup A, but output files must be saved to a 
folder in Domain B or Workgroup B, you can use this feature to specify the credentials 
to access the remote folder.

■ Understanding Authorization Settings

■ Displaying the Authorization Settings Tab

■ Detecting and Resolving Authorization Failures

■ Refreshing the Authorization Record List

■ Adding an Authorization Record

■ Modifying an Authorization Credentials Record

■ Deleting an Authorization Credentials Record

■ Exporting and Importing Authorization Records

Understanding Authorization Settings
Authorization settings are supplemental to Windows account and share settings, which 
should be your primary means of providing access and authentication to required 
storage for Vantage services. When accessing computers in workgroups, Vantage 
administrators should make sure that Vantage services run under an account that has 
access to the locations that it references—then, authorization records are unnecessary 
unless some computers must have unique accounts.

Use the Authorization Settings tab when Vantage services must access shares using an 
account different from the Vantage Windows logon account. Authorization Settings 
allow you to create, test, and manage multiple credentials for various Windows shares 
(on Windows computers) or UNC paths.

When each service starts, it reads all authorization records and stores them for use at 
runtime, as necessary. For example, the Transport service may be called to execute a 
Copy action to write a file to a share or a non-domain server and directory, where the 
service is not authorized by its own account. The Transport service will process the 
authorization records based on the path supplied, to determine if it can gain authority 
via one of its authorization records.

Note: Authorization settings should only be used when the normal Windows account 
and share settings do not provide access to necessary shares: for example, shares on 
other Windows domains, or on workgroups.

The purpose of entering authorization records is to enable Vantage to maintain this 
information for network locations—independent of the authentication inherent with the 
logon account of a specific service—the Vantage Monitor Service, for example. If you 
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know that a specific service does not have the authorization to utilize a given network 
location, you can create an authorization record to provide credentials.

When you provide authorization records for a network location, any service in the 
domain can utilize it.

Note: When you access network locations via Workflow Designer, the locations you 
navigate to are accessed with Workflow Designer’s logon account permissions—
which may be different than the logon account for Vantage services.

However, these locations will ultimately be accessed by Vantage services during 
execution of a workflow—services which may have different users and permissions. 
Therefore, you need to take the extra step of ensuring that the service which will be 
accessing this share at workflow runtime, has authenticated access to the location.

Additionally, authentication does not control sharing and security permissions (for 
example, access, and read/modify/delete/write permissions). Make sure that when you 
set up network locations, you have set each location with the proper permissions for 
the user accounts that will access it.

After you add, modify, or delete a record, click the Save button  to update the records 
in the Vantage domain database as encrypted data.

Displaying the Authorization Settings Tab
To display the authorization settings, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. Select Settings & Options and display the Authorization tab:

3. You may specify authorization records as well as enable the use of a Vantage API 
authorization key.
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Detecting and Resolving Authorization Failures
When you launch the Management Console, Vantage tests each of the authorization 
records to verify that access is assured. (Some authorizations may use local machine 
accounts; others may use Windows user accounts). The results display in the 
Connection Test column:

• Untested—Blank; Vantage has not yet tested this record.

• Success—Green check mark ( ) indicates that Vantage successfully tested the 
authorization record.

• Failure—Red X ( ) indicates that Vantage tested the authorization record and 
failed to connect.

If one or more authorizations fail the connection test, Vantage displays this dialog, 
noting up to three failure and details:

For failures, you should determine the problem and modify the authorization record, 
then click Test to verify the changes.

If you run the Domain Management Console from different workstations, the failures 
may differ, and Vantage may on occasion report false connection failures.

Refreshing the Authorization Record List
To refresh the list of authorization records, move a Vantage service in and out of 
maintenance mode as follows:

1. In the Vantage Management Console, click on Services in the details panel.

2. Right-click the target service and select Enter Maintenance Mode.

3. Right-click the service again and select Exit Maintenance Mode.

Adding an Authorization Record
Click the Add new credentials button  in the toolbar (or right-click and select Add 
new credentials or Import credentials), and supply the details. Click Test to validate the 
record, and click the Save button to add this validated authorization record to the 
database for use by all Vantage services in the domain.
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Modifying an Authorization Credentials Record
Click on the record you want to modify. Make changes to the user name, password, and 
folder and click the Save button  in the toolbar.

Deleting an Authorization Credentials Record
Click on the record you want to delete, click the Delete button  in the toolbar (or 
right-click and select Delete), and click OK to confirm.

Exporting and Importing Authorization Records
Vantage allows you to export an authorization record to an XML file, which you can 
then use to import the same record into another Vantage domain.

To export all authorization records, click the Export menu and select Export All. Use the 
file system dialog to save the exported records.

To export selected authorization records, do this:

1. Select the record to export. Shift-click or Ctrl-click to select multiple records.

Option Description

Username Enter the authorized user name required to access the Windows share 
identified by the UNC path.

If the user account is part of a Windows domain, the user name must 
include the domain or computer name, in the format 
domain\username or ComputerName\Username. For example, 
SierraVideo\Vantage or NewsServer\Bill.

If the user name is part of a workgroup (a non-domain account), you 
must provide the machine name in addition to the user name. For 
example, if you want to use the account: VantageUser that exists on 
machine FooServer1, you should specify FooServer1\VantageUser.

Password Enter the authorized password for the Windows share.

Folder Click Browse and navigate to the Windows share you are 
authenticating. Or, enter it manually. The path must be in valid UNC 
form: \\ComputerName\Sharename\.

Test Click Test to verify that your credentials are entered correctly for 
access to the specified Windows share.

Enable 
Vantage API 
Authorization

Check when Vantage requires a key to perform authorization via an 
API.

API Key Enter the API key authorizing API usage.
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2. Click the Export button  (or right-click and select Export, or click the Export menu 
and select Export Selected).

3. Use the file system dialog to save the exported record.

The default file name is the record name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the record in 
the XML file.

To import an authorization record, do this:

1. Click the Import button  (or right-click and select Import credentials).

2. Use the file system dialog to locate and select the record to import, then click Open.

Note: If you try to import an authorization record that is already in this Vantage 
domain, Vantage prompts you to overwrite the record (click Yes) or cancel the import 
(click No).
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Assigning Mapped Drives
The Mapped Drives tab under Settings and Options in the Management Console 
includes a panel that allows you to assign existing network drives with drive letters 
assigned in Windows to the same drive letters within Vantage and then map the letters 
to UNC paths. This feature supports generic Windows mapped drives, not special SAN 
mapped drives.

The Workflow Designer, for example can access a mapped drive by letter and have that 
mapping translated to a UNC path, saving the time and trouble of looking up and 
supplying a network path each time the drive is used in a Vantage action. 

Note: The Vantage Mapped Drives feature maps drive letters to UNC paths. This 
feature makes data sharing easier among Vantage servers when some servers have a 
drive letter mapped directly to storage and others do not. Those that do not can be 
mapped in Vantage so that all Vantage servers can share data with that storage 
location. The feature should not be used when all Vantage servers already have a 
mapped connection, such as a fiber-channel connection to a SAN system. In such a 
case, the fiber connections are much faster than a UNC path connection, so using the 
Vantage mapped drive to a UNC path would result in a slower connection and a less 
efficient network.

To map a drive in the Mapped Drives panel, follow these steps:

1. Ensure the drive you want to map in Vantage has already been mapped to a drive 
letter in Windows > Tools > Map Network Drive. Arrays require all systems in the 
array to map the drive to the same drive letter.

2. Select Settings & Options in the Management Console left Components panel.

3. Select the Mapped Drives tab in the main panel.

4. Check the Enable mapped drives option.

5. Select the new drive icon  in the top tool row. A drive is added to the drive list.

6. Select a drive letter matching the assigned Windows drive letter using the drop-
down Drive menu near the bottom of the panel.

7. Enter a path to the drive using the UNC Path field. The form of the path is 
\\machine\folder\subfolder\.

8. Click Save in the top tool row to save the mapping of the drive to the path. A dialog 
informs you to restart Vantage services to make the new drive available.



Managing the Vantage Domain
Managing Settings and Options

39

Once the drive letters are mapped to paths, when you specify a drive letter in a Vantage 
application, the UNC path is automatically used to access the desired drive:
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Managing Content Manager | DIVA Connections

Note: Content Manager was formerly named DIVA, up through version 8.3. In this 
guide, the term Content Manager is used to refer to the same product and the terms 
are interchangeable.

When you are using Telestream Content Manager (TSCM) | DIVA for digital content 
management, you can configure connections to a Content Manager server to enable 
the Vantage domain to communicate with Content Manager using the supplied 
credentials. Content Manager actions can then be used in your workflows to identify, 
restore, and archive media in Content Manager.

A Content Manager connection identifies a single system—which may be one of 
several Content Managers which are also in service in your environment. Each Content 
Manager that you want access to must be added to the Management Console before it 
can be accessed from a Vantage workflow.

The Vantage domain and the Content Manager must be on the same network to 
connect and inter-operate.

Adding and Configuring a Connection
To implement a Content Manager connection in Vantage and test its connection, do 
this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings & Options.

3. Select the DIVA tab to display the configuration panel:
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4. Click Add New Setting  in the toolbar or right-click in the connection table’s 
empty area and select Add new setting.

5. Name. Enter the name for the Content Manager (for example, CM_Los_Angeles or 
Sierra_Post_Content_Manager).

6. Address. Enter the IP address or domain name of the Content Manager. IP address 
is more reliable.

7. Username and Password. Enter the credentials Vantage should use to access this 
Content Manager.

8. API Port. (Default: 8765). Enter the port number that the Content Manager is 
listening on for connections.

9. Click the Save icon to save the configuration for this connection.

10. To test the connection, click the Test button at the bottom of the window. 

Deleting a Connection
To delete a connection, do this:

1. Display the Diva tab. 

2. Select the connection to delete. (Ctrl-click or Shift-click to select multiple 
connections.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog displays, click OK. 
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Exporting and Importing Connections
Vantage allows you to export connections to an XML file, which can be used to import 
the same connections into another Vantage domain.

To export connections, do this:

1. Select the connections to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected connections (or right-click and select 
Export, or select Export all from the Export button menu).

3. Use the file system dialog to save the exported connections.

The default file name is the connection name, but you can change the file name.

Note: Changing the file name does not change the name of the connection in the file.

To import connections, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the connection file to import, then 
click Open.

Note: If you try to import a connection that is already in this Vantage domain, 
Vantage prompts you to cancel or confirm replacement.
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Managing Signiant Connections
When you configure a Signiant connection, you enable the Vantage domain to 
communicate with the Signiant server by supplying required credentials. The optional 
Signiant Delivery action can then be used to deliver files to Signiant-enabled servers. 
The Vantage Signiant Delivery action uses the Signiant feature, which must be licensed 
on the Signiant server. A Signiant Agent must be configured in the Management 
Console before it can be used in a Vantage workflow.

Adding and Configuring a Connection
To configure a Signiant Agent connection and test it, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Signiant tab. Vantage displays the 
Signiant agent configuration panel. 

4. Click the Add New Setting button  in the toolbar (or right-click in the empty space 
below the button and select Add new setting).

5. In the Name field, enter a practical name for the Signiant server (for example, 
Signiant-Vantage Server).

6. In the Address field, enter the IP address or domain name of the Signiant server.

7. In the Username field, enter the username from your Signiant server.

8. In the Password field, enter the password associated with the username from your 
Signiant server. 

9. In the Certificate field, paste the CA Certificate text copied from the Signiant server. 
For instructions on obtaining a CA Certificate, see these Signiant CA Certificate 
Instructions.

10. Click the Save icon to save the new agent.

11. To test the Vantage-Signiant connection, click Test at the bottom of the window. 
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You can add Agents as needed for each Signiant server:

Signiant CA Certificate Instructions
 To get a CA Certificate to enable a Vantage-Signiant connection, follow the steps in 
either one of the two procedures that follow:

Use a Web Page to Obtain a Certificate
1. Use a web browser to log into the Signiant server (for example, 

signiant.sierrapost.com).

2. Navigate to Developer > CTE Test Configurations and click Add Configuration.

3. Enter a configuration name and configure settings for your system.

4. In the CA Certificate field (under Advanced Transfer Settings), select the certificate 
text and copy it (including the -----BEGIN CERTIFICATE----- and -----END 
CERTIFICATE----- lines).

5. Click Save at the bottom and close your browser.

6. Paste the certificate text into the Vantage Management Console > Settings & 
Options > Signiant > Certificate field as explained in the previous procedure 
(Managing Signiant Connections).

Use the Command Line to Obtain a Certificate
1. Log into the Signiant Manager host as an administrator.

2. In a terminal window, navigate to the Signiant bin directory.

3. Enter the command dds_cert extract to extract a certificate from the credentials 
store.



Managing the Vantage Domain
Managing Settings and Options

45

4. Open the text file named ddsCA_Cert.pem and copy the entire text (including the --
---BEGIN CERTIFICATE----- and -----END CERTIFICATE----- lines).

5. Paste the certificate text into the Vantage Management Console > Settings & 
Options > Signiant > Certificate field as explained in the previous procedure 
(Managing Signiant Connections).

Deleting a Signiant Agent Connection
To delete a connection, do this:

1. Display the Signiant tab. 

2. Select the connection to delete. (Ctrl-click or Shift-click to select multiple 
connections.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog displays, click OK. 

Exporting and Importing Signiant Agent Connections
Vantage allows you to export Signiant agent connections to an XML file, which you can 
then use to import the same connections into another Vantage domain.

To export connections, do this:

1. Select the connection(s) to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected connections (or right-click and select 
Export, or select Export all from the Export button menu).

3. Use the file system dialog to save the exported connections.

The default file name is the connection name, but you can change the file name.

Note: Changing the file name does not change the name of the connection in the file.

To import connections, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the file to import, then click Open.

Note: If you try to import a connection that is already in this Vantage domain, 
Vantage prompts you to cancel or confirm replacement.
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Configuring Cloud Account Settings
Use the Cloud panel to add and manage Telestream Cloud accounts for use by Cloud 
Qualify, Cloud Speech, transcode actions, and Location actions. These actions send 
media to Cloud for processing using the credentials you enter here to gain access. 
Before you can enter account settings in this panel, you must create an account on the 
Telestream Cloud web site.

Your Telestream Cloud account must also be added to the Cloud tab in order to use the 
HostedWorkflows Manager in Vantage Workflow Designer in a Vantage Cloud Designer 
domain.

To create an account for Telestream Cloud, go to https://cloud.telestream.net/. You will 
be prompted to log in or create an account. When you create an account, the 
Telestream Cloud web site asks you for a user name and provides you with an API Key 
for logging in from Vantage (as well as other keys for logging in directly). Once logged 
in, set up your account for working with Vantage, such as configuring your account for 
Vantage Cloud and configuring projects for Cloud Qualify and Cloud Speech and 
transcoding workflows. See the Telestream Cloud online documentation, tooltips, and 
live chat if you need help. For additional details, refer to the Vantage Cloud User Guide 
on the Telestream web site.

After your account is configured, enter your Name and API Key in the Telestream Cloud 
panel. The Telestream Cloud and Vantage Cloud actions in workflows use these 
credentials to automate logging into Telestream Cloud and sending media to your 
account for transcoding.

Selecting your Cloud account:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Cloud configuration panel:

https://cloud.telestream.net/
http://www.telestream.net/telestream-support/vantage-cloud-port/support.htm
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4. Click the Add New Setting button  in the toolbar (or right-click in the empty space 
below the button and select Add new setting).

5. Enter a practical name and in the API Key field enter the API Key you received when 
you signed up for your Telestream Cloud account. 

6. Click the Save icon to save the new account.

7. To test the connection, click Test at the bottom of the window. A dialog pops up to 
confirm success or failure at logging into the Cloud account.

You can add accounts as needed for each Vantage Cloud account you create.

Obtaining Cloud Account and Store GUIDS for Bindable Cloud 
Mode
When you are configuring Cloud mode workflows and want to use the workflow in 
bindable mode, you’ll require GUIDs for the account and stores. You’ll submit these 
values in variables when you submit a job.

To obtain account and store GUIDs, do this:

1. In the Vantage Domain Console, display the Cloud panel—Settings & Options > 
Cloud. 

2. Right-click on the account you are using for a job and select Details for bindable 
use. The console displays the Telestream Cloud Account Details View dialog:

3. Click Copy to copy the account ID. Paste the account GUID as appropriate for use in 
your job—in a variable or in a workorder file, for example.

4. Locate the store you’re using in the Stores table and click Copy to copy the GUID. 
Paste the store GUID as appropriate for use in your job—in a variable or in a 
workorder file, for example.

5. Close the dialog and continue configuring your workflow in Workflow Designer.
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Deleting a Cloud Account
To delete a configuration, do this:

1. Display the Cloud panel. 

2. Select the account to delete. (Ctrl-click or Shift-click to select multiple accounts.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog displays, click OK. 

Note: Removing an account from Vantage does not delete your Telestream Cloud 
account. 

Exporting and Importing Cloud Settings
Vantage allows you to export your Cloud settings to files, which you can then use to 
import the same accounts into the same or another Vantage domain.

To export the Cloud settings, do this:

1. Select the accounts to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected accounts (or right-click and select 
Export, or select Export all from the Export button menu).

3. Use the file system dialog to save the exported accounts.

The default file name is the account name, but you can change the file name.

Note: Changing the file name does not change the name of the account in the file.

To import accounts from a previously exported file, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the file to import, then click Open.

Note: If you try to import an account that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.
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Configuring Storage Management Settings
The Settings & Options Storage Management panel lets you create, save, export, delete 
and import automated cleanup Storage Rules for Live Stores. This allows you to 
optimize file retention and deletion parameters to best utilize Live Stores.

To configure a Storage Rule, follow these steps:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Storage Management tab. 

4. Click the Add New Rule button in the toolbar (or right-click in the empty space 
below the button and select Add New Rule):

5. Specify a Name and Description for Storage Rule.

6. Specify a utilization Threshold used to trigger a file management cleanup rule. 

7. Select a Cleanup Rule to apply. You can manage files based on creation time or file 
storage capacity.
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Configuring Avid Server Settings
Use the Settings & Options > Avid panel to create, save, export, delete and import Avid 
server connection settings. When you configure an Avid connection, you enable the 
Vantage domain to communicate with the Avid server by supplying required 
credentials. An Avid connection must be configured in the Management Console 
before it can be used in a Vantage workflow.

To configure Avid settings in Vantage and test its connection, follow these steps:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Avid tab. Vantage displays the 
Avid configuration panel:

4. Click the Add New Setting button  in the toolbar (or right-click in the empty space 
below the button and select Add new setting).

5. In the Name field, enter a practical name for the Avid server.

6. In the Web Services Host field, enter the domain name of the Avid server.

7. In the Web Services Port field, select or enter a port number (default 80).

8. In the Production Workgroup field, enter the work group name.

9. In the Production Username field, enter the user name expected by the Avid server.

10. In the Production Password field, enter the Avid user’s password.

11. Click the Save icon to save the new agent.

12. To test the Vantage-Avid connection, click Test at the bottom of the window. 
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Exporting and Importing Avid Settings
Vantage allows you to export your Avid settings to files, which you can then import 
back into your Vantage domains.

To export Avid settings, do this:

1. Select the accounts to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected accounts (or right-click and select 
Export, or select Export all from the Export button menu).

3. Use the file system dialog to save the exported accounts.

The default file name is the account name, but you can change the file name.

Note: Changing the file name does not change the name of the account in the file.

To import accounts from a previously exported file, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the file to import, then click Open.

Note: If you try to import an account that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.

Deleting an Avid Account
To delete an Avid settings configuration, do this:

1. Display the Avid panel. 

2. Select the account to delete. (Ctrl-click or Shift-click to select multiple accounts.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog displays, click OK. 

Note that deleting an account in Vantage does not delete the account on the Avid 
server but only deletes the account settings from Vantage. 
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Creating Dashboard Links
The Settings & Options Dashboard Links panel lets you create, save, export, delete and 
import URLs that appear as frequently used links on the Vantage Web Apps page.

To configure Dashboard Links in Vantage and test the links, follow these steps:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, display the Dashboard Links tab. 

Vantage displays the Dashboard Links configuration panel:

4. Click the Add New Dashboard Link button  in the toolbar (or right-click in the 
empty space below the button and select Add new dashboard link).

5. In the Name field, enter a practical name for the link.

6. In the Address field, enter the URL for the link.

7. Click the Save icon to save the new dashboard link.

8. To test the new link, click the Test button. Your default browser should open to the 
web page you specified. Also open the Vantage Web Apps page and verify that the 
new link is present. 

Exporting and Importing Dashboard Links
Vantage allows you to export your Dashboard links to files, which you can then use to 
import the same links into the same or another Vantage domain.
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To export dashboard links, do this:

1. Select the links to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export menu  (or right-click) and select Export Selected, or Export all.

3. Use the file system dialog to save the exported links file.

The default file name is the base URL, but you can change the file name.

Note: Changing the file name does not change the URL in the file.

To import a previously exported file, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the file to import, then click Open.

Note: If you try to import a set of links that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.

Deleting Dashboard Links
To delete Dashboard links, do this:

1. Display the Dashboard Links panel. 

2. Select the link to delete. (Ctrl-click or Shift-click to select multiple accounts.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog displays, click OK. 
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Managing Vantage File Storage
Vantage storage is disk space that can be used to store files for Vantage processing. 
These topics provide information on Vantage storage:

■ Understanding Vantage Storage

■ Understanding Path Specifications for Vantage Storage

■ Managing Vantage Stores

■ Managing Vantage Folders

Understanding Vantage Storage
Vantage storage is disk space that Vantage can use to store media files and 
attachments. Vantage storage is different from database storage, which stores data for 
Vantage configuration, job/binder status, and system status.

Vantage uses storage for purposes:

• Vantage stores—Managed disk space where media files and attachments are tem-
porarily stored and automatically deleted when they are no longer referenced by a 
binder.

• Vantage folder addresses—Unmanaged disk space to which media files and attach-
ments can be delivered, but from which files are not automatically deleted.

Vantage stores are defined in the Management Console. There are two types of stores 
that may be selected when created: Live Store and File Store. The two types are 
completely separate and cannot be used interchangeably. Live Stores are used by the 
Live Capture action for capture storage. File stores can be used in workflow actions that 
perform file operations (file stores). 

Vantage file stores can also be associated with Vantage services for temporary storage 
(such as the location for a file that is being created during transcoding). Managed files 
remain in a Vantage store while either of these are true:

• The files are referenced by a binder during job processing.

• The files are referenced by a binder that has been registered in a catalog, and the 
binder expiration date has not yet passed.

Vantage folders can be created in the console or in Vantage Workflow Designer. Like 
stores, Vantage folders can then can be used in workflow actions that perform file 
operations. 

Transport actions that are responsible for saving files can use both stores and folders as 
file access and delivery points.
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Understanding Path Specifications for Vantage Storage
Vantage stores and folders can be specified using these path forms:

• UNC form: \\ComputerName\Sharename

• Physical drive-letter form: C:\folder\folder

• Mapped drive managed by SAN client software (for example, StorNext)

Note: Vantage cannot access network locations defined using a Windows mapped 
drive unless you specifically enable mapped drives and map each drive to a UNC path 
using the Settings & Options/Mapped Drives panel. For all network locations other 
than properly configured SAN locations, you must use a UNC path to define network 
locations for Vantage use. 

If all your Vantage services, clients, and storage are on the same server, you can use 
either path form. However, Telestream recommends always using the UNC path form.

The disadvantage to using the drive-letter path form is that the drive letter is defined 
on the local machine, and the drive letter does not identify the computer that hosts the 
drive. For example, if you specify a Vantage store on drive C: using the drive-letter path 
form and a Vantage Workflow Portal operator tries to view files in that store on a 
different computer, the Vantage Workflow Portal will search for those files on drive C: 
on the operator’s computer, not on the Vantage server.

When any Vantage service or client program uses Vantage storage from a different 
computer, you must specify the path using the UNC form. You should also use the UNC 
form if you think you might ever support Vantage services or clients on another 
computer. You can change the path form later, but it is easier to use the UNC path form 
now, and it can prevent troubleshooting issues in the future.

Note: When services or clients will access Vantage storage from another computer, 
the Vantage storage location must be published as a share, and access must be 
granted to the appropriate Windows users. For more information, see Windows 
Authentication Guidelines in the Vantage Domain Management Guide.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.

Note: When creating a store to hold proxy files viewed in Vantage Workflow Portal, 
reference the store with a UNC path. Some SAN clients do not allow frame-accurate 
representation of proxies using shared drives.

Note: The Microsoft User Account Control (UAC) feature may deny access to Vantage 
stores or folders that are placed in protected locations. If Vantage users report that 
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access to a store or folder is denied, place the store or folder in a directory that is not 
protected by UAC on the machine where the store or folder resides.

Managing Vantage Stores
Vantage stores management is performed in the Management Console. When you 
install Vantage in all-in-one mode, a default store named Local Store is created so that 
you can use Workflow Designer and access at least one store. You can add other stores 
as necessary.

To manage your stores, start the Vantage Management Console and select Storage > 
Vantage Stores in the components panel. Vantage displays the Vantage Stores detail 
panel shown in this figure, which shows helpful information such as the name, 
description, offline indicator, type, location, and total and free disk space available for 
the store, as well as space used.

Use the Vantage Stores details panel to view, add, and configure stores. You also use the 
details panel to modify and delete stores.

These topics describe how to manage Vantage stores:

■ Adding and Configuring Vantage Stores

■ Viewing Content in a Vantage Store

■ Modifying a Vantage Store

■ Moving a Store Online or Offline

■ Identifying Workflows that Use a Store

■ Setting the Block Size

■ Duplicating a Vantage Store

■ Exporting and Importing Vantage Stores

■ Deleting a Vantage Store
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Note: The Alias feature (figure) supports the web-based Vantage Workflow Portal 
application described in Managing Web Workflow Portal Client Alias Support in the 
Vantage Domain Management Guide. The Alias field allows entering a path to a virtual 
Vantage store using this pattern: http://IIShostname/Virtual Directory.

Note: If a store's location becomes unreachable or invalid, such as if a system loses 
power, the store name and location will be flagged in red under the Vantage Stores 
listing in the Vantage Management Console.  To prevent attempted usage of such 
stores by jobs in Vantage, Telestream recommends taking such stores offline until the 
issue can be resolved.

Adding and Configuring Vantage Stores
To add a new Vantage store, do this:

1. Click the New Vantage Store button  in the toolbar to display the Add New Store 
dialog (or right-click and select New Vantage Store).

2. Type a name for the store in the Name text box.

The name that you enter here is the name that displays in Workflow Designer when 
an action is configured to access a media file or attachment.

3. To specify the store root directory with a UNC path (recommended), do this:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines in the 
Vantage Domain Management Guide.

4. To specify the store root directory with a drive letter path, do this:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.
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Note: If you use a physical drive letter to specify a directory, only Vantage services 
and clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

5. Select Store type.

Options are File (standard Vantage store) and Live (special store type for Vantage 
Live Capture).

6. Click OK.

7. Click the Save button  to save the new store.

Creating a Live Store
To make a Live Store for Lightspeed Live Capture, set the Type: to Live. For an ordinary 
Vantage Store to be used for non-Live workflows, set the Type: to File. The two types are 
completely separate and cannot be used interchangeably.

Viewing Content in a Vantage Store
The Content text box on the Vantage Stores page displays the content in the Vantage 
store. You can also use tools in the host file system (Windows Explorer, for example) to 
view the contents in the store. To refresh the display of contents, click the refresh 
button .

Modifying a Vantage Store
To modify a Vantage store, do this:

1. Select an existing store in the Vantage Stores list.

2. To change the store name, type a new name in the Name text box.

3. To enter a description for the store, type a description in the Description text box.

4. To specify the store root directory with a UNC path (recommended), do this:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines in the 
Vantage Domain Management Guide.
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5. To specify the store root directory with a drive letter path, do this:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location field, such as 
C:\folder\folder.

Note: If you use a local drive letter to specify a directory, only Vantage services and 
clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

6. To specify a folder naming scheme for the store, select the scheme from the Folder 
Scheme drop down list.

When content is placed in a Vantage Store, Vantage creates a subfolder in the Store 
location to save the files in. If you select Identifier, the subfolder is named by auto-
generating a GUID. Date uses the current time and date stamp, and Name+Date 
uses the content name plus the time and date. For example, a Name+Date sub-
folder for a media file named Butterfly would be named something similar to: But-
terfly_2010-09-17_01-59-50-5785.

7. To take a Vantage store offline, check the Offline check box. Clear the check box to 
bring the store back online. For details, see Moving a Store Online or Offline.

8.  To modify store Type, select File or Live.

9. To set the block size used for the store access, click the Advanced button and follow 
the instructions in Setting the Block Size.

10.  (Optional) Enable Fallback Store. When checked, allows specification of a fallback 
store to use if the specified store is unavailable (file stores ONLY).

11. For information on managing aliases for the store, see Managing Web Workflow 
Portal Client Alias Support in the Vantage Domain Management Guide.

12. Click the Save button  to save the changes.

Moving a Store Online or Offline
There may be times when you want to move a Vantage store offline to perform 
maintenance. When a store is offline, the Offline column in the Vantage Stores list 
displays an X for all stores that are offline. 

When you move a store offline, any jobs in progress that are using that store continue 
to run, but the offline store is no longer available for new jobs. A good practice is to 
take the store offline, let all jobs in progress for that store complete, and then perform 
the planned maintenance. If the store becomes inaccessible before the jobs in progress 
complete, the jobs in progress for that store fail.

To move a Vantage store offline or online, do this:

1. Select an existing store in the Vantage Stores list.
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2. To take a Vantage store offline, check the Offline check box. Clear the check box to 
bring the store back online.

The Offline check box is disabled if the store is assigned to a Vantage service. To 
enable the offline check box in this situation, identify to which service the store is 
assigned, and place that service in maintenance mode. You can located which ser-
vice is using the store by looking at the Storage tab for each service. For more infor-
mation, see Managing Services.

3. Click the Save button  to save the changes.
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Identifying Workflows that Use a Store
You can search all workflows in a domain to see which workflows are using a store. This 
is very useful when you need to change or delete a store, and you want to know which 
workflows might be affected by the change.

To search workflows, do this:

1. Select the store for which you want to search.

2. Click the Search button  in the toolbar. 

If the store is used by any workflows, Vantage displays a list of workflows that use 
the store. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the store is not used by any workflows, Vantage displays a message to that effect. 
Click OK to dismiss the message.
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Setting the Block Size
Vantage allows you to specify the block size used when writing data to and reading 
data from Vantage stores. The default setting works best for most storage systems, but 
some fiber attached storage systems support higher throughput with larger block 
sizes.

Note: The block size feature is only utilized by Vantage Transport related actions 
(Copy, Move, Deploy). It is not used by and does not affect Vantage Transcode Actions 
(Flip, IPTV, Conform, Multiscreen, etc.)

Caution: This is an advanced system feature, and misconfiguration can disable 
your Vantage store. Be sure you understand the block size requirements of the 
storage system before making changes, and consider making changes to a 
production system only when you know the system is idle.

To specify and test a new block size, do this:

1. Click Advanced to display the Advanced Store Settings dialog.

2. Check the Specify desired block size check box.

3. Use the up and down arrows to specify the new block size.

4.  To test the new block size, do this:

a. Click Test.
b. Use the file selection dialog to select a test file, and then click Open.

The test does not open the test file or evaluate file content, so you can use any 
file, regardless of file content. Larger files usually give a more accurate average 
throughput result.

c. Click OK.

Vantage displays the test results.

5. Click OK to save the new setting and close the dialog.
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Duplicating a Vantage Store
To duplicate a Vantage store, do this:

1. Select an existing store in the Vantage Stores list.

2. Click the Duplicate button  (or right-click and select Duplicate).

3. Select the new store and customize it as needed (see Modifying a Vantage Store).

Exporting and Importing Vantage Stores
Vantage allows you to export one or more Vantage stores to XML files, which you can 
then use to import the same stores into another Vantage domain.

To export all stores in the list, click the Export menu and select Export All. Then use the 
file system dialog to save the exported stores.

To export selected stores, do this:

1. Select the store to export. You can Shift-click or Ctrl-click to select multiple stores.

2. Click the Export button  (or right-click and select Export, or click the Export menu 
and choose Export Selected).

3. Use the file system dialog to save the exported stores.

The default file name is the store name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the store in 
the XML file. Also note that exporting a Vantage store only exports the store path 
information, not the contents of the store.

To import a store, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the store to import, then click Open.

Note: If you try to import a store that is already in this Vantage domain, Vantage 
prompts you to either overwrite the existing store (click Yes) or cancel the import (click 
No).

Deleting a Vantage Store
Click on the store you want to delete, click the Delete button  in the toolbar (or right-
click and select Delete), and click OK to confirm.

Note: If there are any files in the store that are maintained by Vantage—such as those 
for unexpired jobs or binders in a catalog, you cannot delete the store. Deleting a store 
permanently removes the store from the domain. It does not delete directories, shares, 
or any files in them.
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Managing Vantage Folders
Vantage folders are aliases (or alternate names) for specific file system directories or 
folders, on any supported file system in Vantage. You can create (and name) Vantage 
folders as URLs, UNCs, or drive letters to identify specific paths you use frequently. 
Vantage folders simplify directory referencing by allowing you to specify a short, 
descriptive folder name instead of a long, complex file path. Vantage folders also allow 
you to update a path or credentials once, and automatically update all actions using 
that Vantage folder.

For example, you might have a folder on a Windows server for HD MPEG2 content: 
\\voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the Vantage folder address book for this path, and name it 
SunupHDWaitingApproval. If you need to change the path or any password associated 
with the address later, you can simply change it in the address book and all actions will 
automatically update.

When you create a workflow that accesses a folder for a file or generates media you 
want saved in this folder path, you simply select SunupHDWaitingApproval in the 
action’s inspector.

For Windows, Telestream recommends using UNC paths instead of drive letter paths, 
and it is required in Vantage arrays. For a detailed discussion, see the table in Using the 
Services Panel.

You can also create Vantage folders in the Address Book to identify buckets in your 
Cloud accounts—Amazon AWS or Google Cloud, for example.

Vantage folder address book management can be performed either directly in the 
Management Console or in Vantage Workflow Designer (in Copy or Move actions).

To manage your Vantage folder addresses in the Vantage Management Console, start 
the Vantage Management Console and select Storage > Vantage Folder Address Book 
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in the components panel. Vantage displays the Vantage Folder Address Book detail 
panel shown here:

You can use the Vantage Folders Address Book details panel to add and configure 
Vantage folders. You also use the details panel to modify and delete Vantage folders.

These topics provide information on managing Vantage folder addresses:

■ Adding a Vantage Folder Address

■ Refreshing the List of Folders

■ Modifying a Vantage Folder Address

■ Identifying Workflows that Use a Vantage Folder

■ Deleting a Vantage Folder Address

■ Setting the Block Size

■ Duplicating a Vantage Folder Address

■ Exporting and Importing Folder Addresses
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Adding a Vantage Folder Address
To add a new folder address, do this:

1. Click the Add Folder button  to display the Add New Folder dialog.

2. Name—Enter the Vantage folder name.

3. Location—Click Modify to display the Folder Location Editor dialog, which presents 
you with a list of all supported file system types in Vantage:

4. Select the file system where the Vantage files will be stored, then click Next.

5. Configure each field or control in each panel to set up the folder address—panels 
and controls vary by file system, of course. 
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6. To specify a Windows directory with a UNC path (recommended), do this:

a. Click Browse to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the folder.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

7. To specify a Windows directory with a drive letter path, do this:

a. Click Browse to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click Select Folder.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.

Note: If the Vantage folder is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines in the 
Vantage Domain Management Guide. Also, if you use a drive letter to specify a folder, 
only Vantage services and clients on the same computer can access the folder. For 
more information, see Understanding Path Specifications for Vantage Storage.

8. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

9. Click OK to save this new Vantage folder address and close the Add New Folder 
dialog.

10. Description—Enter the description, purpose, or use of this folder address.

11. Collision Resolution (not supported on all file systems)—Specifies the action 
Vantage takes when it saves a file with the same name of a file that already exists:

– Create Unique Name—create the file with a unique name, leaving the other file 
intact.

– Overwrite—overwrite the existing file.

– Set Failure State—do not save a new file. Set a Failure state on the action that 
attempted to create the file.

12. To test your connection speed to this location and optimize the block size for file 
transfer, click the Advanced button. For instructions, see Setting the Block Size.

13. Click the Disk icon in the toolbar to save changes to this new Vantage folder 
address.

Note: When using Amazon AWS S3 address locations in Watch and Associate actions 
and when specifying a Vantage folder address, you must also configure specific AWS 
IAM policy settings for S3 access. These are the minimal IAM parameter settings.

Updated IAM permissions list for S3 with Vantage:
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{
"Statement": [
{ "Effect": "Allow", "Action": [ "s3:DeleteObject", 
"s3:GetObject", "s3:ListAllMyBuckets", "s3:ListBucket", 
"s3:PutObject", * "s3.GetBucketLocation"* ], "Resource": [ "*" ] }
]
}

Refreshing the List of Folders
To refresh the folder list, click the refresh button .

Modifying a Vantage Folder Address
To modify a Vantage folder address, do this:

1. Select the folder in the Vantage Folder Address Book list.

2. Name—Enter a new name for the Vantage folder.

This name is displayed in Copy and Move action inspectors where you are specify-
ing the location in which to save a file.

3. Description—Enter the description, purpose, or use of this folder address.

4. Location—To change the folder storage location, click Modify (or right-click the 
folder name in the list and select Modify) and specify the new location as described 
in Adding a Vantage Folder Address.

5. Collision Resolution (not supported on all file systems)—Specifies the action 
Vantage takes when it saves a file with the same name of a file that already exists:

– Create Unique Name—create the file with a unique name, leaving the other file 
intact.

– Overwrite—overwrite the existing file.

– Set Failure State—do not save a new file. Set a Failure state on the action that 
attempted to create the file.

6. Advanced—to test your connection speed to this location and optimize the block 
size for file transfer, click the Advanced button. For details, see Setting the Block Size.

7. Click the Save button .

Identifying Workflows that Use a Vantage Folder
Vantage allows you to search all workflows in a domain to see which workflows are 
using a Vantage folder. This is useful when you need to change or delete a store, and 
you want to know which workflows might be affected by the change.

To search workflows, do this:

1. Select the Vantage folder for which you want to search.
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2. Click the Search button  in the toolbar (or right-click and select Find Workflows). 

If the folder is used by any workflows, Vantage displays a list of workflows that use 
the folder. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the folder is not used by any workflows, Vantage displays a message to that effect. 
Click OK to dismiss the message.

Deleting a Vantage Folder Address
Click on the folder you want to delete, click the Delete button  in the toolbar (or right-
click and select Delete), and click OK to confirm.

Note: Deleting a folder permanently removes the folder from the domain. It does not 
delete directories, shares, or any files in them.
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Setting the Block Size
Vantage allows you to specify the block size used when writing data to and reading 
data from Vantage folders. You can also use Vantage to test the throughput of different 
settings. The default setting works best for most storage systems, but some fiber 
attached storage systems support higher throughput with larger block sizes.

Note: The block size feature is only utilized by Vantage Transport related actions 
(Copy, Move, Deploy). It is not used by and does not affect Vantage Transcode Actions 
(Flip, IPTV, Conform, Multiscreen, etc.)

Caution: This is an advanced system feature, and misconfiguration can disable 
your Vantage folder. Be sure you understand the block size requirements of the 
storage system before making changes, and consider making changes to a 
production system only when you know the system is idle.

To specify and test a new block size, do this:

1. Click Advanced to display the Advanced Store Settings dialog.

2. Check the Specify desired block size check box.

3. Use the up and down arrows to specify the new block size.

4. To test the new block size, do this:

a. Click Test.
b. Use the file selection dialog to select a typical media file, and click Open.

Larger files will usually provide a more accurate average throughput result.

c. Click OK.

Vantage displays the test results.

5. Click OK to keep the save the new setting and close the dialog.

6. Click the Save button .

Duplicating a Vantage Folder Address
Select the folder you want to duplicate, click the Duplicate button  in the toolbar (or 
right-click and select Duplicate). Select the duplicated folder, make the necessary 
changes and save it.

Exporting and Importing Folder Addresses
Vantage allows you to export folder addresses to XML files, which you can then use to 
import the same addresses into another Vantage domain.

To export all folder addresses, click the Export menu and select Export All. Then use the 
file system dialog to save the exported folder addresses.

To export selected folder addresses, do this:
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1. Select a folder in the list, or you can Shift-click or Ctrl-click to select multiple folders.

2. Click the Export button , right-click and select Export, or select Export Selected 
from the Export button menu.

3. Use the file system dialog to save the exported folder addresses.

The default file name is the folder address name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the folder 
address in the XML file.

To import a folder address, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the folder address file to import, then 
click Open.

Note: If you try to import a folder address file that is already in this Vantage domain, 
Vantage prompts you to either overwrite the existing folder address (click Yes) or 
cancel the import (click No).
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Managing Services
The term Services, as used in Vantage, refers to Vantage running as Windows services, 
which are required to perform a given action in a workflow. The term service refers to 
the specific instance of the Windows service on a particular computer that is 
responsible for actually executing the actions specified in a workflow when that 
workflow is executed as a result of a job submission to process a given media file.

Use the Services component of the Management Console to configure your Vantage 
services operating on various machines to function according to your requirements. 

You can configure each service’s program settings, storage requirements, variables, and 
qualification rules.

These topics describe how to manage services:

■ Using the Services Panel

■ Grouping Services

■ Adding a Service to the Domain

■ Removing a Service from the Domain

■ Entering and Exiting Service Maintenance Mode

■ Resetting the Service Metrics History

■ Restarting a Service

■ Changing a Service Log On Credentials

■ Viewing Average Time Spent Waiting

■ Generating Reports

■ Configuring Vantage Services
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Using the Services Panel
To begin Vantage service management, start the Vantage Management Console and 
select Services in the components panel. Vantage displays the Services panel:

Note: If duplicate entries appear for services on a specific Vantage server, it could be 
that the server has multiple network interface cards and one of them has been 
disabled. This does not affect Vantage operation.

The columns in the Services panel are described in the table following.

Clicking a column heading lists the services in order by that column type. Clicking the 
column heading again restores the Services display to the default view. For example, 
clicking the Service column heading organizes the services list alphabetically by service 
name; clicking the Machine column organizes the services alphabetically by machine 
name; clicking State organizes services by state, and so on.
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Column Heading Description

Service Lists Vantage services by name. 

Machine Displays the machine name that hosts the service. 

State Displays the service state:
Online—Running and ready to use.
Offline—Stopped. Right-click and Restart Service or use Task Manager to start.
Unreachable—Service is transitioning states. Wait for completion.
Maintenance—Maintenance mode; right-click to Enter/Exit Maintenance Mode. 

Active Sessions Displays the number of active sessions for the service. A service starts a session 
each time a workflow uses that service to process a job.

Queued Sessions Displays the number of sessions that have been assigned to a service and are 
waiting for the service to become available.

Failed Sessions Displays the number of sessions that did not complete successfully.

Total Sessions Displays the total number of jobs that have used the related service since the 
metrics were last reset.

Session Limit Displays the maximum number of concurrent sessions allowed for a service. This 
setting is made using the Setup tab, Service Limits selection. When cost based 
load balancing is enabled, this setting is disabled. For more information on load 
balancing, see Managing Task Scheduling and Load Balancing.

Average Wait Time Displays the average time that all jobs spend waiting in the queue while the 
service is saturated and unable to take on new jobs. For example, if the service 
has processed 10 jobs and the waiting times were 0,0,0,0,0,0,0,0,0,10 (the last 
job waited 10 seconds), an average wait time of 1 second would be reported. 
This indicator helps to highlight ongoing load imbalances or the need for 
additional computing power to handle overloads.

License Failures Displays the number of times users have requested a service and have been 
denied because no license was available for the session.

Lightspeed 
Fallback Count

For each service, indicates the number of jobs that could have run on a 
Lightspeed Server if one had been available. 
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Grouping Services
Services can be viewed in groups using the Show in Groups button . Once in group 
display mode, the groupings can be changed by clicking the column headings, 
allowing you to view groups by Service, Machine, State, etc. Clicking the Show in 
Groups button a second time restores the default view. 

Adding a Service to the Domain
Before you can add a Vantage service to a domain, it must first have been installed and 
started on a computer on your network subnet.

To add a Vantage service to a domain, click the Add Service button  in the toolbar.

The Vantage Management Console scans the network for available services and 
displays those that are not currently part of this domain:

Select the service you want to add to the current domain and click OK.

Services cannot be part of more than one Vantage domain at a time. Be sure that 
adding a service to your Vantage domain will not harm another Vantage domain by 
removing that service from it.

Removing a Service from the Domain
To remove a Vantage service from a domain, select the service (Shift-click or Ctrl-click to 
select multiples) and click the Delete button  in the toolbar.

Note: Removing a service does not stop or uninstall the service from any computer. It 
merely disengages it from the current domain.
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Entering and Exiting Service Maintenance Mode
You can enter and exit maintenance mode by selecting a service and clicking the Enter 

 or Exit  button (or right-click the service and select Enter/Exit Maintenance Mode). 
When a service is in maintenance mode it will not process any transactions. Exit 
maintenance mode to re-activate the selected service and cause it to reload its 
resources from the database.

Note: Placing a service in maintenance mode erases the metrics for that service, 
which affects the Vantage Dashboard bar graphs for that service. 

Note: The Tachyon Cinnafilm service is supported only on Lightspeed servers. On all 
other Vantage servers, this service stays in Maintenance Mode.

To move multiple or all services on a server in and out of maintenance mode, do this.

1. Display the Services detail panel.

2. Select a service in the list (Shift- click or Ctrl-click to select multiples).

3. Click the Enter button  to place the services in maintenance mode.

4. Click the Exit button  to restart the services and exit maintenance mode.

Note: Placing all services in maintenance mode erases the metrics for all services, 
which affects the Vantage Dashboard bar graphs for those services.

Resetting the Service Metrics History
Click the Clear button  (or right-click and select Clear) to reset the service metrics 
history. This also resets all failed service metrics for the selected services. You can do 
this for multiple or all services by Ctrl-clicking or Shift-clicking the services you want.

Restarting a Service
To restart one or more services, follow these steps:

1. Display the Services detail panel.

2. Select a service in the list (Shift-click or Ctrl-click to select multiple services). 

3. Click the Restart button  to restart the services.

Note: Restarting services erases the metrics for those services.
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Changing a Service Log On Credentials
As part of a workflow, a Vantage service may need to access network folders shared 
only with a certain user account. In such cases, you may need to change the logon of 
that service to the permitted user. To change a service logon, follow these steps:

1. Display the Services panel.

2. Select a service in the list (Shift-click or Ctrl-click to select multiple services). 

3. Click the Change Service Logon button  or right-click and select Change Service 
Log On. A dialog opens, requesting the logon. 

4. Select Local System account to use the account currently accessing Vantage from 
your local machine, or select This account and fill in the user name and password for 
the account that has access to the desired network location. 

5. Click OK. A message confirms that the logon is changing.

Note: Changing a service logon restarts that service. Also note, when changing the 
logon for multiple services simultaneously, some services may not restart properly. If 
this occurs, go to Start > Services on the server, select the affected services, and click 
(or right-click) Restart to manually restart the services.

Viewing Average Time Spent Waiting
The Average Time Spent Waiting button opens a small dialog box that reports the 
average time spent waiting by a service, by an array node, or by the domain. This can be 
helpful in spotting processing bottlenecks at the action, server, and domain levels and 
helping administrators determine when more servers should be added to increase 
processing capabilities during peak load times.

To display the average time spent waiting, follow these steps:

1. Display the Services detail panel.

2. Select a service in the list (Shift-click or Ctrl-click to select multiple services). 

3. Click the Average Time Spent Waiting button . 

4. Select one of the viewing options in the dialog box: 

– By service type to see the average wait time for the service selected in the drop-
down menu.

– By array node to see the average wait time for the server selected in the drop-
down menu.

– Entire domain to see the average wait time for the whole domain.

5. Click Next. The dialog box displays a message showing how much time on average 
the selected item spent waiting (as opposed to actively processing).



Managing the Vantage Domain
Managing Services

78

Generating Reports
The Generating Report button initiates a report from a report format that you have 
already created using the Vantage Management Console Report Configurations > 
Service Reports feature (see the Vantage Domain Management Guide for information). 

Note: This feature requires the Reporting & Analytics option.

To generate a report, follow these steps:

1. Display the Services detail panel.

2. Select a service in the list (Shift-click or Ctrl-click to select multiple services). 

3. Click the Generate Report button . A Generate Service Report dialog box opens.

4. Select from the options in the dialog box: 

– Use the Report menu to select a report from the list of service reports you have 
created.

– In Start, specify a starting time (and date for historical reports) for gathering 
report data. Data that occurred before the Start time (and date) is not included. 

– In End, specify an end time (and date for historical reports) for gathering report 
data. Data after the specified time (and date) is not included.

In the Start and End fields, you can click on each item, including month, date, 
year, hours, minutes, seconds, and AM/PM, and use the selection arrows to set 
each item. You can also click the drop-down arrow to display a calendar and 
select a date.

Note: For historical reports, the number of days of available historical informa-
tion is determined by the Report Retention Time setting in the Settings and 
Options > General tab. This setting retains the past 30 days of information by 
default, or you can set it for a lesser or greater retention time.

5. Click OK, and navigate to the location where you want to save the report file. 
Optionally, modify the report name and click Save. 

A message indicates that the report has been generated, and another message 
shows the location of the report and includes an Open Folder button providing 
access to the report. 

6. To open the folder and access the report, click Open Folder.

Reports can be opened in a text editor or spreadsheet program. If you use a 
spreadsheet program, you can not only view the data in columns and rows, but you can 
also produce charts and graphs using the spreadsheet’s built-in graphing functions.
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Time of Day Report Example
This example depicts a typical TOD report for the Transcode service for a 24-hour 
period (abbreviated to 12 hours to save space). Data is shown at each hour. 

This type of report helps you see which hours of the day may be over- or under-loaded.

Historical Report Example
This example shows an excerpt from a typical historical report for all services on one 
node over multiple days.

This type of report helps you see service or machine loading trends over an extended 
period of time.



Managing the Vantage Domain
Managing Services

80

Configuring Vantage Services
Vantage services have a variety of configuration options; most of them with default 
settings. These topics describe how to configure the settings on each tab:

■ Setup

■ Storage

■ Variables

■ Qualification Rules

Setup
The Setup tab includes Vantage domain database settings, service ports, 
instrumentation, time-out settings and log file options. 

Changing settings in the Setup tab requires that you restart the service before they 
take effect. You can make changes to settings in the other tabs without restarting the 
service—they take effect immediately. To modify the settings in the Setup tab, select 
the service you want to modify and click the Enter Maintenance mode button  in the 
toolbar (or right-click and select Enter). After making the changes, click the Exit 
Maintenance mode button  in the toolbar (or right-click and select Exit). Exiting 
maintenance mode reactivates the selected service and causes it to reload its resources 
from the database so it can begin accepting jobs again.

You can only make changes to these settings in maintenance mode.

Click on each category in the Setup tab to display its settings.

Vantage Domain Settings

Host Name of the computer on which this domain database is installed. 
Not changeable.

Failover Name of the optional fail-over database instance that serves as the 
fail-over database should the primary database fail. This is the 
name of the mirrored database server (i.e. “BackupServer”). 

Instance Name of the primary Vantage domain database instance.

Database Name of the database.

User Username of the Microsoft SQL Server database user. Default: sa. 
Do not change the user name or password unless you have 
created a user with db_owner access for the Vantage instance in 
Microsoft SQL Server.

Password Password of the database user. 
Default: vantage12!
Do not change the user name or password unless you have 
created a user with db_owner access for the Vantage instance in 
Microsoft SQL Server.
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Service Limits

Session Limit In sessions mode (which is the default mode), this configures the 
maximum number of concurrent sessions for a service. For CPU-
intensive services—such the Transcode service—you should gate 
the maximum number of sessions to the power of the computer. 
For less demanding services, such as the Monitor service, a higher 
number is less likely to cause problems. 

The Telestream Cloud service has unique requirements. It should 
be set equal to the maximum number of simultaneous cloud jobs 
based on the current limit on Vantage Cloud.

If the Cloud service is set to a session limit higher than the capacity 
of the Telestream Cloud account, the jobs will be shown as in 
process in Vantage and queued in the Cloud.

When cost based load balancing is enabled, this setting is 
disabled. For more information on load balancing, see Managing 
Task Scheduling and Load Balancing.

Target Resource 
Usage

When cost based load balancing is enabled, this setting configures 
the target resource usage level for this service. Each service has a 
default value for this setting. If server performance permits, raise 
this value to support simultaneous processing of additional 
workflow actions. If the server is having performance issues, lower 
this value to reduce the number of actions that run at the same 
time.

For more information on load balancing, see Managing Task 
Scheduling and Load Balancing.

Service Settings

TCP Port The TCP port is utilized for all intra-service traffic in the domain. If a 
certain port range is allowed by your IT infrastructure (given 
constraints such as routers and firewalls) an IT administrator can 
specify which port to use for intra-service communication to fit 
their environment. The default port settings are listed in the Before 
You Install chapter of the Vantage Domain Management Guide.

HTTP Port The HTTP port is utilized for HTTP server traffic in the domain. An 
IT administrator can specify which port to use for intra-service 
communication to fit their environment. The default port settings 
are listed in the Before You Install chapter of the Vantage Domain 
Management Guide.
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Pause Limit

Pause Session 
Limit

Allows specifying the number of sessions that may be paused for 
these services: Transcode, Multiscreen, IPTV, and Edit. Users may 
then pause multiple sessions up to that number. Note that the 
pause limit is independent of the session limit and may be set 
higher or lower than the session limit. 

Allow Paused 
Actions

When unchecked, actions may not be paused. When checked, 
allows actions to be paused. Hierarchical pausing allows jobs that 
have paused other jobs to themselves be paused. For example, if a 
low priority job is paused by a medium priority job, a high priority 
job may pause the medium job. This feature must be enabled by 
the administrator and set on a service-by-service basis in the 
session limit category for each transcoding service.

Instrumentation Settings

Enable 
Instrumentation

Registers and reports certain internal events as Windows 
Management instrumentation events.

Service Timeout

Timeout The time (in minutes), that a non-responsive task will run before 
being terminated and failed.

Log File Settings

Log File Name The base name of the log file generated by this service. Log files 
are generated by service, and are stored in each service’s folder in 
<installdrive(C:)>\Program Files\Telestream\<Service Folder>.

Log File Size The maximum file size (in bytes) before the service creates an 
incrementally-numbered log file for continued logging.

Max Log File 
Count

The maximum number of log files for this service, before the oldest 
is deleted when a new one is written.

Upload Limit

Concurrent 
Upload Limit

Sets a limit on the total number of concurrent file uploads to the 
cloud allowed for this service. The default is 4 concurrent files.
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Storage
The Storage tab enables you to specify stores for a service to provide a repository so 
that their actions can obtain storage if they require it. Certain actions require storage 
where they can create temporary files or perform other operations that involve writing 
files to disk.

For example, the Transcode service requires access to a store in order to produce the 
files that it creates as part of the transcode process.

The process of assigning a specific store to a service is made with performance in mind. 
If you know you want a particular Transcode service to utilize a specific store, you can 
assign it here. In the absence of an assigned store for Transcode service, service is free 
to utilize any Vantage store it chooses for managing temporary files. This may not be 
optimal based upon your network topology.

Adding Stores

To add a store to the selected service, click the Add Store button , select the store 
from the Select Storage dialog and click OK.

Note: The Flip actions and other actions can also specify a store for output files. The 
selection of a store in an action is separate from stores attached to a service.

Removing Stores

To remove a store from the selected service, select the store and click the Delete button 
 in the toolbar.
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Variables
Use the Variables tab to attach variables to a service. Variables attached to a service 
perform two functions. First, they are used to determine which services can perform 
tasks as set up by the Run On rules in actions executing in the context of a workflow. 
Run On rules allow you to target specific services to execute tasks, based upon whether 
or not a variable is set appropriately for a service. 

Note: Run on rules can only examine the value of variables attached to the service 
executing the action. They are not capable of examining values used in an action. To 
view the variables attached to a service, in Workflow Designer, display the workflow 
and right-click on the target action. Select Run On Rules and click the Check Services 
button at the bottom right. Click the ? icon for help. For more details, see Adding 
Variables to a Service.

Second, variables attached to a service allow workflows to examine their values in the 
context of a job. Variables (such as service hosts and action priority) can be passed to 
workflows to provide information about the service, and workflow actions can include 
this information in the output or make workflow processing decisions based on the 
variable values. 

When you add a variable to a service, you supply a constant (or static) value—one that 
does not change from job to job. The value is static for the service instance. For 
example, you may want to implement email generation in the event of a transcode 
failure in a large domain with 20 concurrent Transcode services, each running on 
separate servers. This allows a user to receive an email when a transcode fails that 
identifies the server where the failure occurred.

To implement this, create a text variable named EmailSubject as described in Creating 
Variables. Next, add the EmailSubject variable to each Transcode service as described in 
Adding Variables to a Service, and set the value of EmailSubject for each service to a 
combination of the respective machine name and the service name by typing it in 
manually in the Value field. For example, one might be named M-ORION-
VantageTranscodeService. 

Finally, in each workflow, add a Message action and specify the email option, bind the 
Subject line with the EmailSubject variable, and set the Message action to only run on a 
Failure state.

Now, if a transcode failure occurs, the user receives an email indicating which server 
was transcoding the media when the failure occurred.

Adding Variables to a Service

To add a variable to the selected service, click the Add Variable button  (or right-click 
and select Add Variable), select the variable from the Select Variable dialog and click 
OK. Next, enter the static value for this variable in the Value field. When you click away, 
the Save Variable dialog displays. Click Yes to save this variable and its value.
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Note: If you are using a Lightspeed Server to host Lightspeed-capable services, 
Vantage automatically assigns a Lightspeed variable to that service, set to True. This 
variable is used for automated load balancing and can be tested by actions in a 
workflow for Run On rule processing or job reporting. Additionally, all Vantage 
services have a system variable, VantageMachineName, set to the name of the host on 
which the service is running.

Removing Variables from a Service

To remove a variable from the selected service, select the variable and click the Delete 
button  in the toolbar (or right-click and select Delete).

Caution: Deleting a variable may render workflows using the variable 
inoperable. When you delete a variable from a service, make sure that you 
modify any affected workflows as well.

Qualification Rules
Qualification rules give you control over which actions a service will process. Using 
these rules, a service compares variable values set by the workflow against a baseline 
value, generates a merit value based on the comparison, and uses that value in 
conjunction with other variables to determine if the service should process the job.

Note: Vantage also supports Run On rules, which are defined in a workflow’s action 
and allow a workflow designer to select a service based on the service’s variable 
values. Generally, Run On rules are easier to configure if you want to specify that parts 
of a workflow execute on specific services. For more information, see the Vantage User 
Guide.

Qualification rules can be based on system variables (such as Priority, K20, and K80) and 
user-defined variables (for example, HD Job or File Size). You can create multiple 
qualification rules per service to fine-tune each service’s fitness to perform certain tasks 
and improve over-all domain workflow and performance.

For example, suppose you have a large domain with 20 transcoding services on 
different machines. Your goal is to divide the transcoding services into groups: those 
that process the bulk of the jobs—those involving media of less than about 80MB in 
size. Another group is configured to optimally transcode media up to 2GB, another for 
long-form files, over 2GB.

To implement this, you create a variable named FileSize (Select Domain > Workflow 
Design Items > Variables). 

Next, you select the service that you want to run short jobs here, in Services > 
Qualification Rules, and create a qualification rule.

Select the FileSize variable and click OK. Configure the rule to specify operator = less 
than or equal, merit = 100 (an arbitrary value), qualifier = required, and value = 
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80,000,000. This rule will pass the merit value of 100 to Vantage when a job being 
considered for execution has a FileSize variable with a value less than or equal to 
80,000,000.

For each other transcode service, add a similar rule (or rules) to qualify it appropriately.

Now, in each workflow, add an Identify action before each Flip action and configure it 
to update the FileSize variable with the File Size metric.

When a job starts, the Identify action updates the FileSize variable, and each transcode 
service examines the variable against its comparison value to determine its fitness to 
process the Flip action, and if true, submits its merit value, if false, submits merit value 0 
to Vantage for final arbitration on which transcode service is assigned the job.

Adding Qualification Rules

To add a qualification rule to the selected service, click the Add Qualification Rule 
button  (or right-click and select Add Qualification Rules), select the variable from the 
Select Variable dialog and then configure the rule.

Option Description

Operator Select an operator from the list to qualify the workflow variable value 
being compared against the baseline value specified in the rule. 

For mathematical operators, if the equation is true, the merit value 
you supply is passed; if the equation is false, 0 is passed. 

For the contains operator, the equation is true if the workflow variable 
contains the text specified in the baseline value. The merit value you 
supply is passed if the equation is true, and 0 is passed if the equation 
is false.

Merit When an action meets the qualification rule requirements for 
multiple service instances, the action is assigned to the service with 
the highest merit value. For example, if a Flip action meets the 
qualification rule requirements for the Transcode service on both 
Server A and Server B, Vantage assigns action processing to the server 
that hosts the service qualification rule with the highest merit value.

Merit values should be consistent with a predetermined plan of 
implementation, so that each service is responding appropriately to 
influence the distribution of tasks. If you have few services and rules, 
values from 1 to 10 may provide enough granularity; for lots of 
services and/or rules, you may need values from 1 to 100 to provide 
enough granularity.

Qualifier Choose Optional when workflows may or may not provide a value for 
comparison. If no value is provided, the comparison always is false, 
and 0 merit is provided. Choose Required when workflows must 
provide a value for comparison. If no value is provided, the service 
rejects the request to process the job without further analysis.
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Deleting Qualification Rules

To remove a qualification rule from the selected service, select the rule and click the 
Delete button  in the toolbar (or right-click and select Delete).

Value Enter the baseline value against which the variable’s value is to be 
compared. (A null value is a valid value.)

Use Wildcards Enables or disables the use of wildcard characters in the Value field. 
When enabled (checked), you can use a question mark (?) to indicate 
a single character that can have any value, and you can use an asterisk 
(*) to indicate a variable number of characters that can have any 
value. For example, *.mov matches any value that ends in ‘.mov’.

When disabled (unchecked), the * and ? characters are regular 
characters, not wildcard characters.

Ignore Case Enables or disables case validation in the Value field. When enabled 
(checked), the case in the Value field is ignored when comparing the 
value to a value received from an action. For example, TEST1 and 
test1 are considered a match when the Ignore Case option is checked.

When disabled (unchecked), the case in the Value field must exactly 
match that received from an action to be considered a match. 

Option Description
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Managing Licenses
Telestream provides Vantage licenses to enable a specific set of capabilities in a 
Vantage domain database. A single license file activates capabilities for every server in 
the domain—functionality that was specified in your license request. Production 
licenses can only be used by one Vantage Domain at a time.

When you receive a license file from Telestream, you need to activate the license file. 
Activation locks the license in the Vantage domain database, and the license remains 
locked until deactivated. Once activated, the license file is no longer used by Vantage. 
However, you should keep the license file in case it needs to be reactivated later.

These topics provide information on managing Vantage licenses:

■ Viewing Vantage Licenses

■ Adding a License

■ Deactivating a License

■ Searching Licenses

■ Portal Sessions

■ Cloud Billing

Note: For details about Vantage Workflow Portal session management, see Viewing 
and Resetting Vantage Workflow Portal Sessions in the Vantage Domain Management 
Guide.

Viewing Vantage Licenses
To view the Vantage licenses in your domain, start the Vantage Management Console 
and select Licenses in the components panel on the left. You use the Licenses details 
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panel to add or remove a license and activate it. Select a license to open and view the 
policies in this license and the capabilities it enables. 

Adding a License
Vantage licenses are normally installed when the domain is installed. For instructions 
on adding a license, see Enabling Vantage Licenses in the Vantage Domain Management 
Guide, Installing Vantage chapter.

Deactivating a License

Note: Before deactivating a license, all jobs using the license should be stopped, and 
all services using the license should be put into Maintenance Mode. Otherwise, the 
license will report being in use.
You can deactivate licenses in Vantage even if there is no network connection.

To deactivate a license in a domain, select the license and click the Remove license 
button  in the toolbar (or right-click and select Delete). Click Yes to confirm.

When you remove a license, Vantage attempts to deactivate it. A license should only be 
removed if you intend to install the same license on a different Vantage domain. In this 
case, the removal process also attempts to deactivate the license. The deactivation 
process will indicate that the license may be loaded on a different domain. If a license is 
not deactivated prior to adding it to another Vantage Domain, an error occurs—
indicating that the license is currently in use on a different Vantage domain and that it 
can not be activated a second time.
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Searching Licenses
You can search installed licenses for a particular word or feature. For example, if you 
have forgotten whether you have bought a particular option, such as Aspera, you can 
enter Aspera in the search field, and any license containing that feature will be listed. 

To perform a license search, click the binoculars button  to open the search dialog. 
Then enter the feature you want to search for.
 

Portal Sessions
The Portal Sessions tab lists Workflow Portal status for any running Workflow Portal 
clients.

Cloud Billing
The Cloud Billing tab is currently deprecated and non-functional. 
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Enabling Open Workflows
To enable or disable the Open Workflows option, do these:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage Domain Management Guide.

2. In the components panel, select Settings and Options.

3. On the General tab in the details panel, check the Enable Open Workflows check box 
to enable this feature, or clear the check box to disable this feature.

4. Click the Save button .

5. Cycle the Vantage services into and out of maintenance mode so the change can 
take effect.

Note: Enabling Open Workflows requires enabling settings in three locations:

• The Vantage Management Console, Settings & Options, General tab, Enable Open 
Workflows

• The drop-down menu at the top of each specific workflow in Workflow Designer

• The context (right-click) menu for each action to be used in open mode

You must check to enable Open Workflows in each of the three locations. Additionally, 
the Open Workflows option license must be purchased and enabled. Not all actions are 
open-capable. For details, refer to the Tours topic in the Vantage User Guide, which 
includes an extensive tour of how to use Open Workflows.
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Viewing Status
When monitoring Vantage or troubleshooting workflow issues, it can be helpful to see 
status information (as shown in this figure) about which workflows and actions are 
active and view information about those workflows and actions. You can also view 
machine activity. 

These topics describe how to use Vantage Management Console to get information on 
the active workflows and actions:

■ Viewing Active Actions

■ Viewing Machine Metrics

■ Viewing the Active Workflows in a Domain

■ Checking Task Status
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Viewing Active Actions
You can view this information about active actions in the Vantage domain:

• Action name •State

• Host Vantage server (machine) •Host workflow

• Job name •Date created

• Date updated •Description

You can view the active actions for a specific service or a specific Vantage server:

■ Viewing Active Actions for a Service

■ Viewing Active Actions by Machine

Viewing Active Actions for a Service
To view the active actions for a service, do this:

1. Start the Vantage Management Console by double-clicking the desktop icon.

2. In the components panel, select Status > Actions By Service.

3. Select the service that hosts the actions you want to view.

Vantage displays a details panel for the service you selected, which lists all active 
actions for that service. You can sort action entries in ascending or descending 
order by clicking a column label.

Note: The Vantage Management Console might not display action list items the first 
time that the Vantage Management Console is started after installation. To resolve this 
issue, close and restart the Vantage Management Console. 

Viewing Active Actions by Machine
To view the active actions for a Vantage server, do this:

1. Start the Vantage Management Console by double-clicking the desktop icon.

2. In the components panel, select Status > Actions By Machine.

3. Select the Vantage server that hosts the actions you want to view. Vantage lists all 
active actions on that server.

You can sort action entries in ascending or descending order by clicking a column label.

Note: The Vantage Management Console might not display action list items the first 
time it is started after installation. To resolve this issue, close and restart the console. 
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Viewing Machine Metrics
Selecting Status > Machine Metrics displays key performance information for each 
Vantage server in the Vantage domain (see the  figure, below). This can clarify 
workloads and bottlenecks at a glance. These are the measurements displayed in each 
column:

• Machine—Lists the name of the machine described by that display row

• CPU Utilization—Shows the percentage of CPU capacity in use

• Network Utilization—Shows the percentage of network throughput being used

• RAM Utilization—Shows the percentage of available memory being used

• Total RAM—Shows the total available memory

• Model—Identifies the Lightspeed server model or Vantage Server for non-Lightspeed

• GPU Utilization—Shows the percentage of total GPU capacity being used

• GPU Memory Utilization—Shows the percentage of total GPU memory in use

• Total GPU Memory Per Card—Shows total MB of GPU memory capacity per card

• Current GPU Memory Per Card—Shows in-use MB of GPU memory per card

• GPU Utilization Per Card—Shows percentage of GPU capacity in use per card

• GPU Memory Per Card—Shows percentage of GPU memory in use per card

• Database Size—Lists the size of the domain database in megabytes

You can sort the list order according to any measure by clicking the column title.

Pre-Shutdown Notification
In the Machine Metrics view, you can prepare to shut down a Vantage node by right-
clicking the machine in the list and selecting Pre-Shutdown Notification. This places all 
services for the node in Pending Shutdown mode as seen in VMC Services. Queued 
sessions will migrate to other services in the domain, and the selected services will go 
offline when their active sessions finish. This prepares the node for Windows shutdown, 
which must be done separately.
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Viewing the Active Workflows in a Domain
When you view the active workflows in the domain, you can view this information 
about each workflow:

• Workflow name •Type of workflow

• Category •State

• Date and time started •Date and time updated

• Scheduled expiration date and time.

This information can help you discover the source of problems. For example, if a 
workflow was working until yesterday and you notice the workflow was updated today, 
you might want to investigate what change was made.

To view the active workflows, do this:

1. Start the Vantage Management Console by double-clicking the desktop icon.

2. In the components panel, select Status > Active Workflows in Domain.

Vantage displays the Active Workflows in Domain panel:

You can sort the workflows in ascending or descending order by clicking a column title.
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Monitoring Utilization
The Utilization feature selected in the Vantage Management Console left panel assists 
system administrators with capacity planning. The bar graph shown in the details panel 
on the right makes it easy to see when a Vantage domain is running under or over 
capacity for specified time periods. Bar heights below the Capacity line indicate 
available unused sessions, whereas bar heights above the line indicate session demand 
beyond capacity, causing session queuing. Bar colors are blue, orange, or red 
corresponding to sessions that had low, medium, or high wait times. 

Specifically, utilization displays this information: 

• Graphs the aggregate of all sessions for a selected service and time period

• Shows all sessions or only successful sessions

• Displays utilization by days in a month or by hours in a day

• Conveys mean session wait time by color (blue, orange, red)

• Shows session capacity making over and under utilization plainly visible

• Intended for monitoring cumulative historical performance, not real-time data.
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Use the Utilization feature as follows:

1. In the top center, select Days or Hours. Days sets the bottom timeline to show all 
days in the selected month. Hours sets the timeline to show 24 hours in the 
selected day. Note: For the Utilization feature to work correctly, all Vantage 
computers must use the same NTP server for synchronized time. 

2. In the top left, select a month or day.

3. In the top right, set the session qualifier to display All sessions or only Successful 
sessions.

4. Scroll the bottom service selector and click a service. The bar graph shows 
utilization for the selected service.

You can adjust the thresholds indicated by the bar colors as follows:

1. Click Modify in the lower right corner. The Wait Time Thresholds dialog opens.

2. Set the low threshold in seconds indicated by the blue part of the bar.

3. Set the high threshold in seconds indicated by the red part of the bar.

4. Click OK. The units shown in the color legend change to match your settings.
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Utilization Display Details

Button or 
Option Description

Days/Hours Selects whether the chart displays a month of days on the timeline or 
24 hours. 

Month/Date Selects a month (if Days is selected) or a specific date (if Hours is 
selected).

Session 
qualifier

Sets the chart to display All sessions for the selected service or only 
Successful sessions.

Service 
Selector

Scrolls left or right to show all services. Click a service to display it on 
the bar graph.

Bar graph Bar heights indicate the overall session demand for the selected 
service type. The bar height value is calculated using time-weighted 
averaging of all active and queued sessions for selected domain 
services over the indicated time period. Bar heights below the 
Capacity line (see Capacity line below) indicate available unused 
sessions for the time period. Bar heights above the Capacity line 
indicate that session demand exceeded capacity, causing session 
queuing. To prevent large session queues from going off-scale, values 
above the Capacity line are displayed using a log base 2 scale, as 
shown by exponential acceleration of the scale marks on the left side 
of the graph. 

Bar color coding presents a separate data set, visually overlaid on the 
utilization demand data described above. The proportion of a given 
blue, orange, or red bar corresponds to sessions completed within 
the time period that had low, medium, or high wait times. These wait 
time thresholds are configurable using the Modify button.

Modify Opens a dialog that lets you set the number of seconds for the low 
threshold (blue) and the high threshold (red). 

Capacity line Shows session capacity for the selected service as a dotted yellow 
line. 

(Note: to change the session limit, select Services in the Management 
Console left column, select the service from the detail list and right-
click it to choose Enter Maintenance Mode. Click the Setup tab, click 
Service Limits, and change the Session Limit. Then right-click the 
service to Exit Maintenance Mode. The capacity line in Utilization 
shows the new limit.)

Refresh Click the green refresh button in the upper left corner, or press F5 to 
refresh the Utilization display.
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Using Support Utilities
The Support Utilities folder contains a collection of log generation and other utilities 
useful in monitoring and managing the domain:

■ Using the Data Collection Utility

■ Using the Change Log

■ Using the Error Log

■ Listing Actions By Service

■ Displaying Plug-in Versions

■ Displaying Software Versions by Machine

Using the Data Collection Utility
The Data collection utility enables you to collect relevant information about selected 
services for transmission to Telestream during a troubleshooting session. You can also 
log point-in-time details about a selected service into a log file for diagnostics 
purposes. 

To open the Data Collection utility, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Support Utilities > Data Collection.

Vantage displays the Data Collection details panel, as shown here in this figure.

To collect data for one or more services

1. Select the service (Shift-click or Ctrl-click to select multiple services)
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2. Click Collect Data. 

Files named for each service are saved in the specified directory. Vantage writes the 
files out as <ServiceType>.txt and displays a dialog to notify you of the location of the 
file so that you can open and read the file or send it to others for analysis.

You can email these files to Telestream for assistance in solving problems during 
troubleshooting sessions.

Using the Change Log
The Change Log utility captures changes to the Vantage domain configuration and 
operation and records these details for each change:

• Date and time of change

• Vantage user who made the change

• Host computer where the change occurred

• Change summary message

To open the Change Log utility, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Support Utilities > Change Log.

Vantage displays the Change Log details panel:

You can use the Change Log utility to copy, delete, and refresh the entries in the change 
log. You can also use filters to display only the log entries that meet your criteria. This 
table describes the Change Log utility controls.
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Button or 
Option Description

Delete button To delete one or more change log records, select the records to 
delete and do one of these:

• Click the Delete button.
• Right-click a selected entry and select Delete.

Copy button To copy one or more change log records to the clipboard, select the 
records to copy and do one of these:

• Click the Copy button.
• Right-click a selected entry and select Copy.
• Press Ctrl-C on the keyboard.

After you copy change log entries, you can paste the records into 
another application document, such as a spreadsheet or word 
processing document.

Refresh 
button 

Click to update the table from the database.

Filter By Check Filter by to enable the filtering controls.

Modify Click Modify to display a dialog that enables you to specify the 
maximum number of log items.

User contains Specifies change log entries that contain the specified text in the 
User field.

Host contains Specifies change log entries that contain the specified text in the 
Host field.

Message 
contains

Specifies change log entries that contain the specified text in the 
Message field.

Newer than Displays change log entries that are newer than the specified date.

Older than Displays change log entries that are older than the specified date.
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Using the Error Log
The Error Log utility captures Vantage errors and records these details for each error:

• Date and time of error

• Error source (Vantage service)

• Host computer where the error occurred

• Type of error (Info or Error)

• Error message

To open the Error Log utility, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Support Utilities > Error Log. Vantage displays the 
Error Log details panel:

You can use the Error Log utility to copy, delete, and refresh the entries in the error log. 
You can also use filters to display only the log entries that meet your criteria. The Error 
Log utility controls are described in this table.
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Button or 
Option Description

Delete button To delete one or more error log records, select the records to delete 
and do one of these:

• Click the Delete button. Select Delete All or Delete Selected.
• Right-click a selected entry and select Delete.

Copy button To copy one or more error log records to the clipboard, select the 
records to copy and do one of these:

• Click the Copy button.
• Right-click a selected entry and select Copy.
• Press Ctrl-C on the keyboard.

After you copy error log entries, you can paste the records into 
another application document, such as a spreadsheet or word 
processing document.

Refresh 
button 

Click to update the error log display.

Filter By Check Filter by to enable the filtering controls.

Modify Click Modify to display a dialog that enables you to specify the 
maximum number of log items.

Source 
contains/
excludes

Specifies error log entries containing or excluding the specified text 
in the Source field. 

Host 
contains/
excludes

Specifies error log entries containing or excluding the specified text 
in the Host field.

Message 
contains/
excludes

Specifies error log entries containing or excluding the specified text 
in the Message field.

Newer than Displays error log entries that are new than the specified date.

Older than Displays error log entries that are older than the specified date.
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Listing Actions By Service
To display a list of actions in the domain by service, open the Vantage Management 
Console and select Support Utilities > Actions By Service. Then click a service on the left 
to see its details on the right.

This feature lets you see many of the details about an action:

• Name of the action

• Description, including selected media format

• Date it was created

• Version with which it was created

• Workflow in which it resides

• Category where the action’s workflow is located.

• Template used to create it

You can sort the list by clicking on any column heading.

The arrow buttons above the action list allow you to export the selected actions to an 
XML file. You can then import previously exported XML files. Using this feature, you can 
transfer configured actions between Vantage systems, or save them as backups.

The Workflow icon allows you to open the workflow containing the action using the 
Vantage Workflow Designer.

The green Refresh button refreshes the list if you have made changes to any listed 
actions.
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Displaying Plug-in Versions
Use the Plug-in Versions utility to display the list of plugins in the domain by service, 
including their version number. Plug-ins reside in the domain database and are 
available to perform functions required by multiple services. 

To open the Plug-in Versions utility and display information for a service, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Support Utilities > Plug-in Versions By Service.

3. Click a service to display the details panel for that service.

Vantage displays the details panel for the service, which will be similar to the Metadata 
service details panel.
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Displaying Software Versions by Machine
Use the Software Versions by Machine utility to display the list of machines in the 
domain and examine the versions of services and transcoding software components on 
each machine. This allows you to see which transcoding and analysis engine is installed 
on each machine, and which patches. All Vantage machines should use the same 
engine and patch versions.

To open the Software Versions by Machine utility and display version information, do 
this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Support Utilities > Software Versions by Machine.

3. Click a machine icon to display the Vantage and services versions installed on that 
machine. 
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Managing Task Scheduling and Load Balancing
These topics provide information on managing load balancing:

■ Enabling Task Scheduling/Load Balancing

■ Overview of Session and Cost Based (Legacy) Load Balancing

■ Examples of Cost Based Load Balancing (Legacy)

■ Overview of Task Based Load Balancing

■ Configuring Task Based Load Balancing

■ Enabling Task Scheduling/Load Balancing

■ Examples of Task Scheduling

Enabling Task Scheduling/Load Balancing
Task Scheduling is an umbrella term that includes the default Session Based selection 
and the optional Cost Based and Task Based Load Balancing selections. The Advanced 
Task Scheduling license enables all three selections, so you can choose among them 
(they are mutually exclusive). Without the Advanced Task Scheduling license, only the 
Session Based selection is available.

To enable or disable any of the three Task Scheduling options, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage Domain Management Guide.
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2. In the components (left) panel, select Settings and Options, and select the General 
tab in the details (right) panel.

3. Under Task Scheduling, check the Session Based, Cost Based Load Balancing, or Task 
Based Load Balancing check box to enable a load balancing feature. 

4. Click the Save button  above Task Scheduling.

5. When the Service Restart Required dialog displays, click OK.

6. Restart all Vantage services by clicking Services in the left panel and then right-
clicking each service in the right panel and selecting Restart Service. (You can Ctrl-
click or Shift-click to select multiple services.) As a quicker alternative to restarting, 
you can enter and exit all services into and out of maintenance mode.

Note that this merely enables the features. Using the features requires appropriate 
licensing and configuration in other panels, as explained below.
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Overview of Session and Cost Based (Legacy) Load 
Balancing

These topics explain Session and Cost Based Load Balancing; Task Based Load 
Balancing is covered later as a separate topic. 

Session and Cost Based Load Balancing methods govern and balance the workload for 
each service on individual or multiple Vantage servers. For example, if you have the 
Transcode service running on three Vantage servers, the Flip action, which is processed 
by the Transcode service, can run on any of the servers. Load balancing determines 
which server receives the action to process.

Session-Based Load Balancing
Session-based load balancing, which is included with Vantage and does not require a 
license, allows you to distribute the processing of actions across multiple servers that 
support the same service. Session-based load balancing distributes action processing 
among the available servers up to the configured session limit for each server. 

Note: A Lightspeed K20 Server can run a maximum of six concurrent Lightspeed jobs 
regardless of the capacity setting. (K80 Lightspeed servers have no such concurrency 
limit.) The default session limit setting for each transcode service is four. This helps 
ensure the server retains enough GPU memory to efficiently process all jobs. If 
Lightspeed jobs fail because they exceed memory limits, try a lower setting.

This load balancing is done by taking the CPU capacity and current utilization of each 
machine into account, as well as ensuring that any Run On rules are observed. (Run On 
rules allow tasks to be routed to specific machines. They are configured in the 
Management Console > Services > Variables and are set in the Workflow Designer by 
right-clicking on actions and selecting Run On Rules.) 

When the configured session limit is reached on all servers, actions are queued until the 
workload drops below the configured session limit. (An exception to this is that some 
actions support the pause for priority feature in which an action pauses, yielding to a 
higher priority action of the same type.)

You set the Session Limit in the Vantage Management Console by selecting Services 
and selecting the service you want to change. The Session Limit is listed in the Setup 
panel below the services list. To change the limit for a service, you must first right-click 
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and select Enter Maintenance Mode, which enables the Session Limit selection. After 
changing the Session Limit, right-click the service and select Exit Maintenance Mode.

Cost Based Load Balancing (Legacy)
Cost based load balancing is a legacy method that has been improved upon by Task 
Based Load Balancing. Cost based load balancing requires a Vantage Array license and 
the Advanced Task Scheduling license and allows you to do this:

• Assign a default cost for each type of action used in workflows

• Define a target resource usage level for each service on a server

• Override the default resource cost in workflows as needed

Note: Session limits are ignored when cost based load balancing is enabled, and the 
target resource usage level is ignored when session-based load balancing is enabled.

To determine its available resources, each service monitors the total cost of all actions it 
is processing and compares that cost to the configured target resource usage level for 
that service. A service can accept an action for processing if the available resource 
usage is at least half the cost of the action.

Unless priority is used, actions are assigned to services in the order in which they are 
processed, which prevents low cost actions from consuming all service resources and 
starving higher-cost actions. Each action is forwarded to the service with the most 
available resources. If the action is forwarded to a service that does not have resources 
to immediately process the action, the action is queued for later processing.

To implement cost based load balancing, enable the feature (as described in Enabling 
Task Scheduling/Load Balancing) to monitor:

• Server performance using server monitoring tools.
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• The Services panel in the Vantage Management Console, which displays a list of 
services, including the current and target resource usage levels. For more informa-
tion, see Using the Services Panel.

If the server is under- or over-loaded, you might adjust the default target resource 
usage level for each service as described in Configuring Vantage Services.

To adjust the default resource cost of an action, search for Managing Actions in the 
Domain Management Guide. For information on overriding an action’s default resource 
cost in a workflow, see the Vantage User Guide.

Examples of Cost Based Load Balancing (Legacy)
You can use the target resource usage setting to limit the total action cost that a service 
will simultaneously process. For example, if you configure the Transcode service for a 
target resource usage of 16 and you configure the default Flip action resource cost to 4, 
the Transcode service supports a maximum of 4 simultaneous Flip actions.

Some services support multiple actions, and you can set the action resource cost for 
each action to a different value to define the relative usage levels. For example, the 
Transport service supports the Copy, Delete, Deploy, and Move actions, which are 
assigned default resource costs of 2, 1, 1, and 2, respectively. Based on the default 
values, a Transport service can support twice as many Delete and Deploy actions as 
Copy and Move actions.

Different codecs require different levels of processing resources. Using Workflow 
Designer, you can override the default resource cost for specific actions within a 
workflow. For example, you might configure a Transcode service to target resource 
usage of 16, specify a resource cost of 1 for a 3GP Flip action, and a resource cost of 8 for 
an MPEG-2 HD Flip action. During load balancing, Vantage will ensure that:

• No more than two MPEG-2 HD jobs execute simultaneously

• Up to 16 3GP jobs can execute simultaneously

• One MPEG-2 HD and eight 3GP jobs can execute simultaneously in ideal situations

• MPEG-2 jobs are not starved by 3GP jobs which only require one slot.

Note: Resource costs are integer values that have an ordinal relationship. You can 
implement any scale. Greater scales enable finer-grained control.
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Overview of Task Based Load Balancing
Vantage Task Based load balancing is Vantage's most advanced load balancing 
capability and augments the existing Vantage Session Based load balancing and the 
Vantage Cost Based load balancing. Task Based load balancing ensures that all Vantage 
servers remain fully utilized, maximizing server efficiency and increasing workflow 
throughput. Task Based load balancing also helps avoid the situation where some 
Vantage servers are over utilized and others are under-utilized. 

The older session-based and cost based methods discussed previously are limited to a 
single service on a single machine. These methods can prevent a service from 
becoming overloaded, but they cannot effectively balance between different types of 
actions on a single machine, and they do not offer a global way of managing sessions 
across multiple machines.

Task based load balancing is a separately licensed option that provides a single set of 
metrics shared across all services for scheduling tasks and balancing workload on a 
single machine or all the machines in a domain. 

These are the key features of task based load balancing:

• Each metric can be edited and has machine scope (across all services on the 
machine) or global scope (across all services on all machines). 

• Each metric has two inputs: Cost (set for each action) and Capacity (set per 
machine, or globally). You can edit both on a per-machine basis (for per-machine 
metrics) or for the entire Vantage Domain (for global metrics).

• A default metric called System Resources is pre-configured to provide a per-
machine metric. This metric cannot be deleted and must remain per-machine. 
However, you may set the capacity for this metric on each machine, and you may 
remove the metric from an individual action.

• You can create and name your own new metrics.

• By default, each metric has machine scope, but you can edit this after creation.

• The default capacity is 100 “units” for each machine, allowing each cost to indicate 
the resource percentage an action uses. The capacity can be changed.

• You can choose which metrics are relevant to an action, and you can set the cost for 
each action.

• When executing a task:

– Vantage evaluates all metrics that you attach to the action. If a metric is not 
attached to an action, it is not considered.

– Vantage tracks the aggregate cost of all executing actions on a machine, across 
all machine-based metrics, and will track the aggregate cost of executing actions 
across the entire system for global metrics.

– Vantage only executes an action when the aggregate cost of executing current 
actions, plus the new task, does not exceed the capacity of any of the metrics 
attached to the task.
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Vantage will never execute a task when the aggregate cost of executing actions, 
including the new task, would exceed the capacity of any of the metrics attached to the 
task.

• When tasks are queued, they may be pre-empted only by higher priority actions:

– Certain high priority tasks will pause an appropriate number of low priority tasks 
(executing on the same service on the same machine) to free up sufficient 
resources across all metrics, to allow that high priority task to execute. If doing so 
would exceed the maximum number of paused jobs specified by the user, then 
the high priority task will wait until a different set of tasks are present which may 
be paused. Pauses will not occur across multiple machines; they occur only for 
actions hosted by the same service.

The new task based load balancing capability allows you to define custom task 
scheduling rules which allow jobs to be controlled/allocated based on criteria on a 
given machine or across an entire domain.

Vantage task based load balancing is enabled via the settings panel in the Vantage 
Management Console. As with other system level settings, when task based load 
balancing is enabled (or changed), services must be restarted to implement the new 
settings.

Task based load balancing includes capabilities that replace and extend the Cost based 
load balancing mode. The new capabilities replace the existing action cost 
mechanisms, and are used in-conjunction with the existing service capacity to provide 
more granularity on when and where an action may run.

Configuring Task Based Load Balancing
These topics explain how to configure task based load balancing. The overall process 
consists of these steps:

1. Install the Advanced Task Scheduling license via the Vantage Management Console 
> Licenses panel.

2. Enable Task Based Load Balancing in Vantage Management Console > Settings & 
Options > General. 

3. Put all Vantage services in Maintenance mode

4. .Set Service and Session limits for each service in the Vantage Management 
Console > Services panel. This limits how many actions can run within a given 
service to prevent service overload.

5. Take the services out of Maintenance mode to restart them.

6. Create machine and domain rules in the Vantage Management Console > Task 
Rules > Task Scheduling Rules. You can create multiple rules to govern machine and 
domain capacities under different operating circumstances. 

7. Adjust the capacity of rules for machines and domains using the Vantage 
Management Console > Task Rules > Task Capacity Manager.
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8. Apply default costs and rules to actions using the Vantage Management Console > 
Workflow Design Items > Action Defaults. You can use the Configure Task 
Scheduling button to set default values and rules to apply to each action.

9. When creating workflows in the Workflow Designer, you can use the action 
defaults, or you can customize costs and rules for specific instances. To customize 
an action, right-click the action, and select Resource Cost > Configure Task 
Scheduling.

10. Monitor overall rule operation on machines and the domain using the Vantage 
Management Console > Status > Task Scheduling Status panel. Monitor workflow 
performance in the Workflow Designer Status panels, such as Domain Job Status.

Task Scheduling Rules Panel
The Task Scheduling Rules panel shown below provides a list of currently defined task 
scheduling rules. This panel allows machine or domain task scheduling rules to be 
added, configured, managed, and deleted. For the currently selected rule, you can set 
the default capacity for the rule and the Scope of the rule.

The System Resource rule is a system task scheduling rule that may not be deleted or 
changed and is assigned to any new machine added to a Vantage domain.

To add and configure a task scheduling rule, follow these steps:

1. Click Task Scheduling Rules in the left panel to open the Task Scheduling Rules 
panel on the right.

2. Click the Create a new rule button  in the upper left corner of the panel.

3. In the Create New Rule dialog, select a Machine rule or a Domain rule and click OK. 
A Machine rule applies to a particular Vantage node, and a Domain rule applies to 
all nodes in the domain. The Scope you choose displays in the bottom panel.
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4. In the bottom panel, name the rule, describe it, and if you wish change the Default 
Capacity. Capacity is the percentage of a machine or domain to devote to a service.

5. Click the Save button  to save the rule. The new rule displays in the rule list.

These are the controls available in the Task Scheduling Rules panel:

Create a new rule—  Adds a new machine or domain task rule.

Delete a rule—  Deletes the selected rule from the rule list.

Save a rule—  Saves a newly created or edited rule.

Duplicate a rule—  Replicates the selected rule. Be sure to enter a new name.

Show usage—  Lists actions and workflows where the selected rule is used. A rule 
must be located and deleted from all actions and workflows before you can delete it 
from the list.

Import—  Imports rules previously exported as XML files.

Export—  Exports rules as XML files that can be reimported using the Import function.

Note also that the above listed controls are also available in context menus. Right-click 
in the open space below rules to see a context menu containing the New Rule, Import 
Rules, and Export Rules functions. Right-click a particular rule to access Delete, 
Duplicate, Show usage, and Export functions.

Task Capacity Manager Panel
The Task Capacity Manager panel lets you assign Task Scheduling Rules to particular 
machines or to the domain.

To apply a task scheduling rule to a machine or domain, follow these steps:
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1. Click Task Capacity Manager in the left panel to open the Task Capacity Manager 
right panel.

2. Click the Machines tab to add rules to a machine, or click the Domain tab to add 
rules to the domain. 

3. For machines, select the machine to which you want to apply a rule; for the domain, 
no selection is required.

4. Click the Add rule button, and select a rule from the list to apply to the domain or 
the selected machine. 

5. At the bottom of the panel, set the Capacity that you want to apply. 

6. Click the Save button to save your changes. Once saved, rules cannot be changed 
without putting Vantage services into maintenance mode. 

These are the controls for the Task Capacity Manager Panel:

Refresh—  Refreshes the machine list to detect machines that have come online.

Add a rule—  Adds a rule to the selected machine or domain.

Delete a rule—  Deletes the selected rule from the rule list.

Save a rule—  Saves changes to added rules.

Capacity—Changes the maximum percentage capacity allocated to a rule.

Action Task Scheduling
To add task scheduling rules to actions in a workflow, follow these steps in the Vantage 
Workflow Designer.

1. Right-click the action, and select Configure Task Scheduling.

2. In the Task Scheduling Rules dialog, select Custom or Default. Use Custom to apply 
rules you’ve created. Use Default to apply existing system rules.

3. Select the rule you wish to apply to the action from the Rule list. 
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4. You can also select Resource Cost Settings and specify custom costs. 

Action Defaults for Task Scheduling
Action default costs and task scheduling rules apply to all actions of a specified type 
globally. These can be set up for each action in the Vantage Management Console > 
Workflow Design Items > Action Defaults. By setting up the default Resource cost and 
using Configure Task Scheduling to set up default rules, you can reduce the number of 
times you have to specify custom rules when you deploy individual actions.

For details about setting Action Defaults, see the Vantage Domain Management Guide > 
Configuring Vantage Workflow Components chapter > Managing Action Default Settings.
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Checking Task Status
To check the status of running task rules, click Task Scheduling Status in the Vantage 
Management Console left panel. The state of machine and domain rules is displayed.

Examples of Task Scheduling
These brief examples present scenarios where load balancing may be useful:

Example: The user sets the Transcode Service session limit to 6 and creates a new Rule 
called Transcode with a capacity of 100 associated with machine #1. The user then 
defines a Flip action and specifies a cost of 10. The user starts the workflow with this 
action and submits 10 jobs. 

Because the session limit is explicitly set at 6, only 6 jobs execute despite the capacity of 
100 specified in the rule and the fact that only 60 units of cost are used. 

If the user stops the transcode service and changes the session limit to 12, restarts the 
workflow and re-submits 10 jobs, all 10 would execute (since the cost of each job is 10 
and the machine has a capacity of 100). If the user submitted 2 additional jobs; these 
would queue (since the capacity of the machine is limited to 100 and there are 10 
actions running (each with a cost of 10).

Example: The user installs Vantage and enables task based load balancing. By default, 
all Multiscreen and IPTV VOD transcodes have a System Resource cost of 25, and each 
machine has a capacity of 100. By default, only 4 transcoding jobs of any type will run 
on each machine.

Example: The user sets the System Resources cost of a Multiscreen action to 100 and 
the cost of another IPTV VOD action to 50. The capacity of each machine is the default 
(100). Now only one of the Multiscreen jobs, or two of the IPTV VOD jobs, can execute at 
a time.
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Example: The user creates a machine-level rule called “FTP Sessions” and sets the 
machine capacity for “FTP Sessions” to 1. The user then adds “FTP Sessions” to a 
Transport action, and sets the cost to 1. This limits the number of FTP transfers from 
that machine to one at a time, which is useful for FTP sites that can only allow one 
connection from a machine at a time.

Example: The user creates a rule called “Omneon Sessions” and sets it as a global rule, 
with a capacity of 1. The user then adds the metric “Omneon Sessions” to a Transport 
action, and sets the cost to 1. This limits the number of Omneon connections to one at 
a time across the entire system.

Example: Four tasks are running on one machine, each with a cost of 20. The aggregate 
cost of those running actions is 80. When a new task arrives with a cost of 25, it will not 
execute because doing so would exceed the capacity of the machine (100). Any tasks 
that arrive after that action will be queued behind the action (unless one has a higher 
priority).

Example: A high priority task (cost 50) pauses two low priority tasks (cost 25 each, total 
50) to execute.

Example: A high priority task (cost 50) cannot execute because ten tasks are running, 
each with a cost of 10, and the pause session limit is set to 3; the high priority task 
would have to pause too many tasks. In this situation, the high priority task will wait 
until two jobs complete (so that it can pause three).
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Viewing Client Connections
Clicking the Client Connections selection in the Vantage Management Console left 
menu panel opens the Client Connections window. This window lists the currently 
open clients in the domain and their hosts and indicates the last time the list was 
updated for each client. 

The delete button ( ) lets you highlight clients and delete them from the list. Deleting 
a client only removes it from the list and does not close the client. Clicking a column 
sorts the list according to that column. 
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Managing Vantage Users
The user management feature determines which users have access to these:

• Vantage web applications

• Vantage Workflow Portal configurations

• Workflow categories in the Vantage Workflow Designer client application

• Vantage Management Console

The Vantage administrator uses the Vantage Management Console to create, remove, 
and edit user profiles and Active Directory accounts. Vantage users are allowed to 
change their own passwords.

These topics describe how to manage Vantage users:

■ Enabling and Disabling User Administration

■ Managing Users with Vantage Management Console

■ Adding Users

■ Setting Passwords

■ Removing Users

■ Importing and Exporting Users

Enabling and Disabling User Administration
User administration is disabled by default so a Vantage login is not required to use 
Vantage. If you enable user administration, Vantage users will be required to log in 
using a Vantage user name and password that is assigned to them by the Vantage 
administrator or by using their Windows Active Directory login. 

To enable or disable user management, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Settings and Options.

3. On the General tab in the details panel, check the Enable user administration check 
box to enable this feature, or clear the check box to disable this feature.

4. Also check Use Windows Active Directory for Users if you would like to allow users 
to use their Windows login for logging into Vantage. 

5. See Managing Users with Vantage Management Console for details about adding 
user accounts if you enabled user administration.

Note: When you disable user management, users do not need to enter a user name 
and password to log in to Vantage Management Console, Vantage Workflow Designer, 
or the Vantage Workflow Portal client application. To access most Vantage web 
applications, users must enter a user name and password. The exception for Vantage 
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web applications is Job Status Views. When public access is configured for Job Status 
Views, users do not need to enter a user name and password.
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Managing Users with Vantage Management Console
To start user management in the Vantage Management Console, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the Settings & Options > General panel, check Enable user administration, which 
must be enabled in order to manage users. You can also select Use Windows Active 
Directory for Users to allow logging in using Windows accounts.

3. In the components panel, select Users.

Vantage displays the Users detail panel shown in this figure:

The default user account is for the administrator. The account’s user name is 
“administrator” with no password. This account exists even if you do not add any users.

After you add users, you can select each user or Ctrl-select multiple users and assign or 
restrict privileges using the check boxes and Set Password button at the bottom of the 
window. Click Save after making changes. See these topics for details.
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Adding Users
The procedure to add users differs slightly depending on whether you use Windows 
Active Directory or not. This figure shows the two different Add User windows. 

Adding Users Without Windows Active Directory

To add a new user without using Windows Active Directory, follow these steps:

1. Click the New User button  or right-click and select New User.

2. Enter the username and password (and confirm the password) in the dialog box. 

3. Check the Administrator check box if you want the new user to be an administrator.

4. Click OK to add the user, and then click Save  to save your changes.

Adding Users With Windows Active Directory

The Vantage Active Directory feature allows you to create users and groups in Windows 
Active Directory and add them as users in Vantage. You can assign them a Vantage role 
either as regular users or administrators. 

For example, if you add a group and choose to assign Administrator privileges to the 
group, each member of the group defined in Windows Active Directory will have 
Vantage administrator privileges. If you choose not to check the Administrator box 
when adding the group, users in that group are added as regular Vantage users without 
administrative privileges.

Note that individual user accounts take precedence over group accounts. For example, 
if user johnk is part of a group assigned as regular users, you can also add johnk as a 
separate user and set this account to be a Vantage Administrator. The separate account 
definition overrides the group settings for that user.

Also note that to use Active Directory, the machine must be logged on or joined to the 
Active Directory domain, and the administrator adding users must be an Active 
Directory user. 

To add a new user or group using Windows Active Directory, follow these steps:

1. Click the New User button  or right-click in the empty user list and select New 
User. 
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2. Enter part or all of the user name in the blank field and click Find Now to search for 
and list users whose names match the text you entered. 

The drop-down menu lets you select a filter for your search, and the Users and 
Groups check boxes allow searching for users, groups, or both (default).

3. Select a user in the displayed list.

4. Check the Administrator check box if you want the new user to be an administrator. 

5. Click Add to add the user, and then click Save  to save your changes. 

Setting Passwords
To set a user’s password, select the user, and click the Set Password button (or right-
click the user in the list and click Set Password). When the dialog box displays, enter 
(and confirm) the user’s password. Click OK to close the dialog box, then click the Save 
button  to save your changes.

Setting Administrator or Read Only Access
Select the user or Ctrl-click to select multiple users and check the appropriate boxes at 
the bottom of the window to add or restrict privileges. 

If you select the Administrator check box when adding the user or afterwards, the user 
has complete access to change any settings in the Vantage domain. 

If the user is not an administrator, the User cannot change password check box is 
available. Check the box if you want to prevent the user from changing the password. 

Non-administrators cannot access the Vantage Management Console unless you allow 
limited access by checking Read Only. Read Only allows users to see but not change 
these Vantage Management Console functions: Services, Licenses, Status, Domain 
Workflow Analytics, Utilization, and Support Utilities.

Click the Save button  to save your changes.

Removing Users
Users can be removed by selecting the user in the Users list and clicking the Delete 
button  at the top of the User Management panel (or right-click the user and select 
Delete). When requesting the removal of a user, a dialog box will display asking you to 
confirm this action. You cannot undo the removal of a user, thus to restore a user you 
must add the user again as a new user.

Importing and Exporting Users
User lists can be imported and exported. To import a list of users, click the Import 
button , navigate to the XML file containing a list of users, and click the Open button. 
To export a list of users, click the Export button  (or right-click the list and select 
Export), enter an XML filename for the list of users, and click the Save button.
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Managing Domains
Managing a Vantage Domain includes backing up and restoring the domain database, 
shrinking the database, renaming a domain, and renaming a server.

■ Backing Up and Restoring the Vantage Domain Database

■ Understanding Domain Backup and Restore

■ Backing Up the Domain

■ Restoring the Domain

■ Shrinking a Full Database

■ Renaming a Vantage Domain

■ Renaming a Vantage Server

Backing Up and Restoring the Vantage Domain Database
The domain backup feature allows you to save archival copies of the Vantage domain 
database in a separate file. The domain restore feature allows you to replace your 
current Vantage domain database with the contents of a previously-backed up domain. 
The domain backup and restore features are primarily used for:

• Returning the database to a previously backed-up state.

• Preparation for database mirroring.

Note: The domain backup and restore features are not designed for use during 
Vantage upgrades. If you back up the database from a specific version of Vantage, that 
backup can only be restored to the same Vantage software version. During a Vantage 
upgrade, the Vantage installers manage any required database updates as described 
in Upgrading from the Previous Version in the Vantage Domain Management Guide.

These topics describe domain backup and restore:

■ Understanding Domain Backup and Restore

■ Backing Up the Domain

■ Restoring the Domain

Understanding Domain Backup and Restore
During a domain backup, Vantage creates a single backup file that contains all 
workflows, all services, and all jobs registered in the domain. It is important to 
remember that the backup file contents reflect the domain contents as of the moment 
the backup file is created. To capture changes made after a backup, you must create 
another backup.

When you restore a domain, all services are stopped, the current database contents are 
irretrievably destroyed, and the backup file you specify is used to create the 
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replacement database. The services defined in the backup file are started and the 
Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database, 
Telestream recommends that you back up the current database before restoring a 
previous database. Backing up the current database captures all database changes 
made since the last backup, and it gives you a backup file that you can use to restore 
the current database if necessary. 

Backing Up the Domain
To back up the Vantage domain database, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel.

3. Verify that all services in the Active Services list are hosting 0 sessions.

Note: Although you can create a successful backup while services are executing 
workflow tasks, some job records may be lost. It is best to back up the domain when 
there is no activity in the domain.

4. Click the Backup... button.

5. In the Save the domain dialog, browse to the folder where you want to store the 
backup file, and click Save.

6. When the Backup Complete message displays, click OK.
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Restoring the Domain

Caution: Telestream recommends that you restore a Vantage domain using the 
same machine that created the backup file. If you restore the domain from 
another machine, the services defined in the database must match the services 
installed on the other machine.

To restore a Vantage domain database, do this:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel.

3. To provide the option to return to the current Vantage domain database later, back 
up the current domain database as described in Backing Up the Domain.

Caution: Always back up your current database before restoring it to an earlier 
backup. Restoring your Vantage domain database overwrites the entire contents 
of the current database with the contents of the backup file selected.

4. Verify that all services in the Active Services list are hosting 0 sessions.

Note: When you restore a domain, all services are stopped, and all information 
related to any jobs in progress is lost. The restored database contains only the domain 
information captured when the domain was backed up.

5. Click the Restore... button, read the information dialog that displays, and click OK.

6. In the Load the domain dialog, browse to the backup file you want to restore, select 
the backup file, and click Open.

7. When the Restore Complete message displays, click OK.

Shrinking a Full Database
If a Vantage installation using SQL Express nears the SQL Express database size limit, 
Vantage stops accepting jobs. Attempts to submit jobs manually launches a warning 
dialog indicating that the database is at or near capacity. 

You may be able to resolve this issue using the Vantage Shrink Database feature, which 
applies the MS SQL DBCC SHRINKDATABASE command to the existing database to 
delete unused entries and reduce file size. The shrink process may take some time and 
may slow database performance, so it should be done only when the Vantage system is 
not busy.

Use this procedure to shrink the database:

1. Start the Vantage Management Console.
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2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel.

3. To protect against potential data loss, use the Backup... button to back up the 
current domain database as described in Backing Up the Domain.

4. Click the Shrink button to shrink the database. 

A dialog pops up to explain that the Shrink command may affect database perfor-
mance and should be done only when Vantage is not busy.

A Status message indicates progress.

Current Size displays the database size next to the button, so you can see any 
changes immediately upon completion of the shrink command. 

Multiple presses of the button may shrink the database additionally each time. 

Renaming a Vantage Domain
Each Vantage domain uses the name assigned to the Windows server that hosts the 
Vantage domain database. To rename a Vantage domain, you must complete these 
tasks (which are described in more detail later in this topic):

• Remove all Vantage services from the Vantage domain.

• Rename the Windows server that hosts the Vantage domain database.

• Restart the renamed server and add all Vantage services to the renamed domain.

Note: If the Vantage domain database is a mirrored database, you must remove any 
Vantage licenses prior to renaming the Vantage domain. If you do not remove the 
licenses first, your licenses will become invalid after the rename is complete.

When you remove Vantage services from the domain, the Storage, Variable, and 
Qualification rule configuration for each service is lost. The rest of the Vantage domain 
configuration is retained. After the Vantage domain is renamed, all Vantage users and 
administrators will need to specify the new Vantage domain name when connecting to 
the domain with Vantage client or web applications.

Note: To complete this procedure, you must have permission in your Windows 
domain to rename the computer, or you must get assistance from your Windows 
domain administrator. Be sure to schedule the rename during a maintenance window, 
as renaming the Vantage domain interrupts all Vantage services in the domain and all 
Windows services on the server to be renamed.

Use this procedure to rename a Vantage domain:

1. Start the Vantage Management Console, select the domain to manage, and log in 
as described in Starting the Vantage Management Console.

2. Select Services in the components panel.
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3. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

Write down any Storage, Variable, and/or Qualification Rule settings that you want 
to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar.

6. Click Start > Control Panel > System.

7. Click Change Settings in the right panel. The System Properties window opens.

8. Select the Computer Name tab and click Change.

9. Edit the computer name in the Computer Name text box and click OK.

10. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.

Note: If you do not have the appropriate permissions, contact the administrator for 
your Windows domain.

11. Restart the server.

12. Start the Vantage Management Console, select the new domain to manage, and 
log in.

13. Select Services in the components panel.

14. Click the Add Service button  in the toolbar.

15. When the Select Service dialog displays, click Machine to sort the services by 
machine name.

16. To add Vantage services for a specific machine, select the services you want and 
click OK.

17. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.

18. Send the new Vantage domain name to all Vantage users and administrators so 
they can reconnect to the Vantage domain.

Renaming a Vantage Server
To rename a Vantage server, you must complete these tasks (which are described in 
more detail later in this topic):

• Remove all Vantage services for the server to be renamed from the Vantage 
domain.

• Rename the Windows server.

• Restart the renamed server and add all Vantage services on the renamed server to 
the Vantage domain.
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Note: Do not use this procedure to rename a server that hosts the Vantage domain 
database. Instead, see Renaming a Vantage Domain.

When you remove Vantage services from the domain, the Storage, Variable, and 
Qualification rule configuration for each service is lost. The rest of the server 
configuration is retained.

Note: To complete this procedure, you must have permission in your Windows 
domain to rename the computer, or you must get assistance from your Windows 
domain administrator. Be sure to schedule the rename during a maintenance window, 
as renaming the Vantage server interrupts all Vantage services and Windows services 
on the server to be renamed.

Use this procedure to rename a Vantage server:

1. Start the Vantage Management Console, select the domain to manage, and log in 
as described in Starting the Vantage Management Console.

2. Select Services in the components panel.

3. Take note of any Storage, Variables, and/or Qualification Rules settings for the 
service node you want to rename.

Write down any Storage, Variable, and/or Qualification Rule settings that you want 
to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services. 
(NOTE: If renaming just a service node and not a domain database server, then only 
the service node's services need to be unassigned from the domain.)

5. Click the Remove Service button  in the toolbar.

6. Click Start > Control Panel > System.

7. Click Change Settings in the right panel. The System Properties window opens.

8. Click Change System Properties in the right panel.

9. Select the Computer Name tab and click Change.

10. Edit the computer name in the Computer Name text box and click OK.

11. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.

Note: If you do not have the appropriate permissions, contact the administrator for 
your Windows domain.

12. Restart the server.

13. Start the Vantage Management Console, select the domain to manage, and log in.

14. Select Services in the components panel.

15. Click the Add Service button  in the toolbar.
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16. When the Select Service dialog displays, click Machine to sort the services by 
machine name.

17. To add Vantage services for the renamed server, select the services you want and 
click OK.

18. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.
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Managing ComponentPacs
This topic describes the ComponentPac Management tab in the Vantage Management 
Console. For additional details, see Upgrading and Modifying Vantage.

ComponentPacs are distributed for updating transcoding-related actions. They are 
uniquely-versioned software libraries for these actions: 

• AAF • Asset Monitor

• Analyze • Capture

• Chronicle • Compose

• Conform • Flip64

• IPTV Flip • Multiscreen Flip

• Tape • Tempo

• Timed Text Conform • Timed Text Flip

• Media Creation

These libraries are not installed or uninstalled using the Windows installer; they are 
installed and managed separately from the Vantage framework. ComponentPacs are 
drop-in packages that you install into a Vantage domain using the ComponentPac 
Management feature of the Vantage Management Console. Using the ComponentPac 
Management feature, you can install them from a central location of your choice or the 
default local cache. A central location accessible to all Vantage servers is required for a 
Vantage array or a Vantage domain having multiple client machines.

ComponentPac management provides secured version control for affected Vantage 
actions. ComponentPacs are managed and reconciled automatically on each node 
within a Vantage domain to ensure all nodes contain the same packages and versions. 
Each node is checked to ensure it has the correct packages installed, and if not, the 
correct packages are retrieved and installed from the central file location. Thus, if you 
move a node from one domain to another, the ComponentPac Management feature 
will reconcile the new node with the other nodes in the domain.

Note: The Vantage framework is installed and removed using a Windows-based 
installer from Telestream, and if a change is required within the Vantage framework, 
such as to non-transcoder service components, those updates are made using a 
Vantage patch or update pack, not a ComponentPac. The Flip, Identify, and Examine 
actions are also not managed by ComponentPacs.

ComponentPac management also includes features for managing which 
ComponentPacs are used by workflows and actions. You can upgrade ComponentPacs 
but continue to use old ComponentPacs for particular workflows and actions. You don’t 
have to upgrade workflow and action functionality until you are ready. For details, see 
the Vantage User Guide topics on upgrading actions and workflows.
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Using the ComponentPac Management Panel
This figure shows the ComponentPac Management panel in the Vantage Management 
Console. To access this panel, select ComponentPac Management in the left menu.

• The ComponentPac storage location field allows you to enter or browse to a central 
location where ComponentPacs will be stored. If not specified, the default location 
is C:\Program Files (x86)\Telestream\Vantage\ComponentPacs\.

• The Install new package button opens the Install ComponentPacs window, which 
enables you to select new downloaded ComponentPacs and install them by click-
ing the Install button. 

• The Installed ComponentPacs list on the left side of the panel shows all installed 
ComponentPacs and allows you to select packages to manage.

• The Summary tab opens a panel that shows details about the package selected in 
the Installed ComponentPacs list.

• The Actions tab opens a panel listing workflows and actions that use the package 
selected in the Installed ComponentPacs list. 

• Use the Find actions referencing an absent ComponentPac button to locate actions 
that need upgrading to use a new ComponentPac after a previous one has been 
removed.
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Installing ComponentPacs
Installing new ComponentPacs as explained below makes them available for use but 
does not affect existing jobs, actions, or workflows until you explicitly upgrade them. 

1. Obtain the new ComponentPac from Telestream.net or Telestream Support and 
place it in a folder accessible by the Vantage Management Console.

2. Open the Vantage Management Console, and click ComponentPac Management in 
the left column. Installed ComponentPacs, if any, are listed in the Installed 
ComponentPacs list on the right. 

3. In the right panel Storage Location field, enter or browse to specify a path to a 
central ComponentPac storage location. This is where new downloaded packages will 
be stored and installed from. If you do not specify a path, the default location is used: 
C:\Program Files (x86)\Telestream\Vantage\ComponentPacs\.

Note: For an all-in-one (single node) installation, the ComponentPac storage location 
can be a local path. For a multi-node installation (Vantage array), the ComponentPac 
storage location must be accessible to the Vantage services on all Vantage servers (via 
a UNC path or a SAN drive letter with appropriate permissions). 

One convenient way to securely install ComponentPacs from a share is to use Vantage 
Authorization credentials. To do this, create a share for a single user which is a different 
login than the logins to Windows or Vantage. (Shares can be created for single or 
multiple users or groups, and the user can be the same or different from the Windows 
user login.) Then in the Vantage Management Console, go to Settings & Options > 
Authorization and add the credentials for the share user. Next, restart the services to 
recognize the new credentials, and then test share access. You can now use the share as 
your ComponentPac central storage location.

1. Click the Install new package button. 

2. Browse to the location where you downloaded the ComponentPac. Click on the 
ComponentPac file you want to install, and click Open. (Skip this step if the 
ComponentPac you are installing is already in the location specified in step 3.)

3. Check the desired ComponentPac in the Install ComponentPacs window, and click 
Install to install and register the package with the domain.
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4. When installation finishes and the package displays in the Installed 
ComponentPacs list, restart all affected services on all nodes to deploy the 
ComponentPacs.

ComponentPacs are unpacked and made ready for use when the Vantage services 
targeted by the ComponentPac are restarted. Unpacked pacs are stored in C:\Pro-
gram Files (x86)\Telestream\Vantage\Components\ on each Vantage service node.

Notes:
1. New actions and workflows created in the Workflow Designer use the latest 

installed ComponentPac. However, existing actions and workflows must be 
selected and upgraded to use the latest ComponentPac. If they are not upgraded, 
they will continue to use the ComponentPac with which they were created. See the 
Vantage User Guide for detailed action and workflow upgrade instructions.

Once an action is upgraded, you can't directly downgrade it. However, you can 
restore workflows to their pre-upgraded state by importing the automatic backup 
copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the 
Workflow Designer client). A log file describing the upgrades is also included in that 
directory. 

If you want to change the location of automatic ComponentPac backups, open the 
Vantage Management Console, select Settings and Options, and browse for a new 
Location for workflow backups. 

2. Workflows created with a previous version of Vantage (such as Vantage 6.3) use the 
earliest ComponentPac installed. When you upgrade a workflow created with an 
older Vantage version, the actions are tied to the latest ComponentPacs currently 
installed.

3. The Session Log available in the Workflow Designer Job Status or Domain Job 
Status panel lists which ComponentPac was used for a completed job. 

4. If a Vantage service is unable to unpack a ComponentPac (such as when the 
Vantage service does not have the appropriate user credentials to access the file 
location of where the ComponentPac file resides), an entry is added to the service 
trace log to record the issue.

5. If you convert a single-node Vantage domain to a multi-node Vantage domain and 
if the installed ComponentPacs reside in a local path, the ComponentPacs must be 
copied or moved to a shared folder location and re-installed or re-registered.

6. Once workflows and actions have been upgraded to the latest ComponentPac they 
cannot be reverted back to previous versions.

7. Upgrading Vantage via an update pack may cause ComponentPac actions to be 
shown as eligible for upgrade even though a new ComponentPac has not been 
installed. This is normal behavior for update packs. You can upgrade the 
ComponentPac actions or not, as you prefer.

8. Attempting to install a future ComponentPac that doesn't match the current 
Vantage version fails to install the ComponentPac and displays an error message: 
“ComponentPacs built for a future release of Vantage are not supported, and will 
not be installed.”
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Uninstalling ComponentPacs
To remove old ComponentPacs:

1. Open the Vantage Management Console, and click ComponentPac Management in 
the left column. Installed ComponentPacs are listed in the Installed 
ComponentPacs list on the right. 

2. Click the package you plan to uninstall and check the Actions panel for affected 
workflows and actions.

Export all workflows that reference the ComponentPac you want to uninstall (to 
back them up), and then delete the workflows in Vantage.

3. Click the Uninstall button in the ComponentPac Management window while the 
package to be removed is selected. 

Note: The Uninstall button displays only when a package is not used by any actions. 

4. After uninstalling is complete, restart the affected Vantage services. If the Workflow 
Designer was open, close it and reopen to all the changes to take effect.

The selected old package is removed and no longer displays in the ComponentPac 
Management list.
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